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مـــقـــدمــــة

Adobe Animate ًباسم  ، المعروف سابقاAdobe Flash  هو برنامج لتأليف الوسائط المتعددة والرسوم المتحركة ،

 بالكمبيوتر.

، ونشر نفس الشيء للبرامج التلفزيونية والفيديو عبر تصميم رسومات متجهة ورسوم متحركةل Animateيمكن استخدام 

 لفيديو.الإنترنت ومواقع الويب وتطبيقات الويب وتطبيقات الإنترنت الغنية وألعاب ا

ولنوضح الأمر  , Vector Graphics الشعاعية أو المتجهة هو أحد البرامج القائمة على الرسوم Animate إن برنامج

 : أكثر نقول

: أشكال الجرافيكس إلى نوعين تنقسم

1 .Bitmap Images  أو الرسوم النقطية , وتسمى أيضا Raster Images , يرةوتتكون من شبكة من المربعات الصغ 

Pixels ,ودرجة لونية ثابتة كما أن العدد الإجمالى للمربعات يكون ثابتا ,ولذلك عند تغيير  وكل مربع يكون له مكان ثابت

درجة مقبولة من تفاوت الألوان  العمل بالتكبير فإنه يفقد جزءا كبيرا من وضوحه ودقته , هذا النوع من الصور يظهر حجم

 .الأخرى والتصاميم المنتجة بالفوتوشوب أوبرامج التلوين م الصور الفوتوغرافيةوالظلال , و يندرج تحت هذا القس

2.Vector Graphics بطريقة الأشكال  أو الرسومات المتجهة أو الشعاعية , وتتكون من خطوط ومنحنيات تعرف

جهات يمكن إظهارها هندسية. ورسومات المت وتصف المتجهات الرسم وفقا لأرقام ,Vectors الحسابية وتسمى المتجهات

ذلك على جودتها ودرجة وضوحها , فعند التكبير ستتعدل الصيغة  فى أى حجم بالتصغير أو التكبير دون أن يؤثر

 صلية , حيث تحتفظ بمنحنياتهاعرض الصورة بوضوح بنفس التناسب مع أبعاد الصورة الا الرياضية ببساطة ويتم

الحجم , كما تم تصميمه  بغض النظر عن Flash مستعرض أن تعرض ملف وخطوطها الناعمة , وبالتالى يمكن لنافذة أى

 . الحفاظ على تناسب التصميم أصلا , أى ستظهر الصورة واضحة بدون أى تسننات للحواف مع

: ببرامج الرسم مثل ويندرج تحت هذا القسم أيضا الرسوم والتصاميم المنتجة

Free Hand Corel Drew, Macromedia Flash Adobe Illustrator

Bitmap والثانية من نوع Vector والأولى من نوع , وأترككم مع هاتين الصورتين لتوضيح الفرق بين النوعين
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. أضعاف 8الحالتين , وقد قمنا بالتكبير مرتين , للضعف , ثم  يحدث عند تكبير جزء من الصورة فى ونلاحظ ما

فهو يقدم للإنترنت ملفات صغيرة الحجم نسبيا  Vector Graphics لمتجهةاسلوب الرسوم ا Animate ونتيجة لإستخدام

 الصيغة الرياضية بكل بساطة , وبالتالى Animate , سيعدل 2إلى نقطة  1عديدة من نقطة  , فبدلا من تحريك بيكسلات

. يتحرك الشكل بنعومة وفاعلية

 فتح ملف عمل جديد

كما يلي:  Animateفي   تي قمت بمعاينتها للتو من خلال بدء مستند جديدستقوم بإنشاء الرسوم المتحركة البسيطة ال

 .File> Newاختر  

New Documentيفتح مربع الحوار 

 يظهر في هذا المربع ثلاث أعمدة هي :

الايسر لفتح الملفات التي عملنا بها مؤخرا .1

نفتح منها ملفا جديدا باختيار  .2

Action script 3.0

روابط لتوضيح ه العمود الثالث في .3

و    Animate  الإضافات الجديدة في 

بعض الفيديوهات التعليمية
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 فيتم فتح الواجهة التالية:  Action script 3.0نختار  

 عندما نختار أي أداة من شريط الأدوات لاستخدامها يتم عرض خصائص هذه الأداة في شريط الخصائص.

 Workspacesواجهات العمل 

( التي قد تتناسب  (Workspaces"مساحات العمل"او المعدة مسبقاً  الواجهاتيضًا بعض أ Animateوفر ي

و تسمى   Animateتمثل هذه الواجهة الواجهة الأساسية للعمل في بشكل أفضل مع احتياجات مستخدمين معينين. 

لتي نحتاجها للعمل في و تعني الأساسيات لانها تحتوي على كل العناصر الأساسية ا  Essentialsهذه الواجهة ب 

Animate . 

اسب مع احتياجات معظم المصممين، نتتي و الت Workspacesكما انه يوفر مجموعة أخرى من الواجهات 

   Window> Workspacesولاختيار احدى الواجهات نختار 
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يتم توفير نفس الوظيفة بواسطة مبدل مساحة العمل في الطرف الأيمن من شريط التطبيق.كما 

إعادة ترتيب الألواح المختلفة وتغيير حجمها وفقاً لأهميتها في مساحة العمل المختارة. على سبيل المثال ،  يتم

حيث ان  المخطط الزمني في الأعلى للوصول السهل والمتكرر. Designerو  Animatorتضع مساحات عمل 

 خاصة بالمختصين بالتحريك فقط و ليس رسم الشخصيات.  Animatorواجهة 

ا قمت بنقل بعض اللوحات حولها وأردت العودة إلى إحدى مساحات العمل التي تم ترتيبها مسبقاً ، فاختر إذ

Window> Workspaces> Reset   وانقر فوقOK .في مربع حوار التأكيد

. Window> Workspaces> Essentialsللعودة إلى مساحة العمل الافتراضية ، اختر 

 حفظ مساحة العمل الخاصة بك

إذا وجدت ترتيباً من اللوحات يناسب أسلوب عملك ، فيمكنك حفظه كمساحة عمل مخصصة والعودة إليه في وقت 

 لاحق.

 قم بتغيير مواقع اللوحات كما تريد  .1

نكتب اسما للواجهة الجديدة. يظهر مربع الحوار.ف New Workspaceنختار  Essentialsمن لائحة  .2

من  Lightاو الفاتح   Darkيمكن ان نختار بين اللون الداكن   Interfaceملاحظة: لتغيير لون الواجهة 

نختار اما داكن او فاتح User Interfaceثم من   Generalثم من   Preferencesثم   Editخلال اختيار 

المسرح

، فإن  . كما هو الحال مع المسرح المسرحيالمسرحيطُلق على المستطيل الأبيض الكبير الموجود في منتصف الشاشة 

يحتوي على النص والصور  تكون المسرحية شغالة.قة التي يراها المشاهدون عندما هي المنط Animateفي المسرح 

والفيديو الذي يظهر على الشاشة. حرك العناصر داخل وخارج المسرح لوضعها داخل وخارج الرؤية. يمكنك استخدام 

( لمساعدتك في وضع العناصر على المسرح. View> Grid> Show Grid( أو شبكات )View> Rulersالمساطر )

 بالإضافة إلى ذلك، 

حيث يمكنك وضع العناصر التي لن تكون مرئية )الكواليس( بشكل افتراضي ، سترى المنطقة الرمادية خارج المسرح 

 View> Magnification> Clip Toفقط ، اختر  المسرحلجمهورك. المنطقة الرمادية تسمى لوح اللصق. لمشاهدة 

Stage  لتحديد الخيار. يمكنك أيضًا النقر فوق الزرClip Content Outside The Stage  لاقتصاص العناصر

 لترى كيف سيشاهد جمهورك مشروعك النهائي. Stageالرسومية التي تقع خارج منطقة 

ي المنطقة الرمادية لن باختصار، العناصر الموجودة على المنطقة البيضاء ستظهر عند عرض الفيلم، بينما الموجود ف

 يظهر لانها كواليس بالنسبة للفيلم.
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لتغيير نسبة العرض او المشاهدة للعناصر على المسرح نستطيع ذلك باختيار الحجم المطلوب من القائمة الموجودة في 

 الزاوية العليا اليمنى.

 تغيير خصائص المسرح
وذلك بالنقر داخل المسرح لتظهر خصائص المسرح في جزء تخدم يمكن تغيير خصائص المسرح حسب رغبة المس

properties  : و التي نستطيع من خلالها

الثانية , وهى  إطار فى 24إن السرعة الإفتراضية هى   :سرعة الفيلموهي  الواحدة الثانية في الإطارات عدد .1

 .ثانيةفى ال  إطار كادر 24لسرعة الأفلام السينمائية وهى  مماثلة



2024قسم تكنولوجيا المعلومات / خضوري اعداد: أ.أوس رحال

7

 العمل مسرح مساحة تحديدو(. Ins , Point , Centimeters , Millimeters, Pixels ) القياس وحدة تحديد .2

)الطولعرض وال)

 .العمل مسرح خلفية لون تحديد .3

إطارا  72إلى  ثوانى , تستطيع بسهولة فائقة استنتاج أنك تحتاج 3لدينا عنصرا نريد ظهوره لمدة  فمثلا لو

الخيارات التى اخترتها هى  جعل نانقر هنا إذا أردفإننا ن Advanced propertiesفي     Make Defaultاما زر 

 . شئ فيها فيلمانت الإفتراضية , بحيث تكون هى الخيارات الفعالة فى كل مرة

الأدواتشريط 

تتيح  Animateالأدوات في 

لك رسم، اختيار، وتعديل 

تتيح لك منطقة  .العمل الفني

ت أسفل لوحة الخيارا

ديل الأداة إمكانية تع الادوات

 شريط التي حددتها. إذا كان

غير مرئي، يمكنك  الأدوات

عرضه من خلال تحديد 

Window    ثم Tools 

الشكل التالي يوضح الأدوات 

المتوفرة.
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Selection Toolأداة التحديد  .1

. لهذا الشكل Stroke والخط الخارجيFill تحديد لكل من : الملءويجب عند تحديد عنصر بشكل كامل أن تقوم بعمل 

 Ctrl استحضار هذه الأداة بشكل مؤقت لاستعمالها فى التحديد بالضغط على وأثناء استعمالك لأى أداة أخرى يمكنك

تكون الأداة فوق خط خارجي  بهذه الأداة أيضا عمل بعض التغييرات على الأشكال . مثلا فى الصورة التالية عندما يمكنك.

. الخط تتحول لهذا الشكل دليلا على أنه يمكنك إضافة استدارة لهذا
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يمكنك سحب الزاوية  على أنهتكون الأداة فوق زاوية مستطيل مثلا يتغير الشكل المصاحب لمؤشر الماوس دلالة  وعندما

  . أو للخارجللداخل 

لوح  ييظهر ف على احد العناصر المرسومة في المسرح اختيار هذه الأداة وعند 

  ارات كما فى الصورةالخي properties الخصائص  

تختلف الخصائص المعروضة تبعا للجزء المحدد حاليا من الشكل. فإذا كان الجزء  

خارجي نستطيع تغيير المحدد هو الخط ال

 لونه 

 )عرضه )سماكته

 شرطات....( -منقط- نمطه )متصل

 اما اذا كان الجزء المحدد هو تعبئة الشكل فنستطيع تغيير لون هذه التعبئة

ملاحظة:

فذلك  بكثرة فى الدروس المقبلة , لذا لنتفق من الآن عندما يطلب منك تحديد كائن على المسرح " ستتكرر كلمة " تحديد

إحاطة الكائن بتحديد وهمى بأداة السهم ,  يعنى أن تقوم باستخدام أداة التحديد والنقر على الكائن مرتين ) دبل كليك ( أو

 . للكائن Fill والملء Stroke يالمهم يجب تحديد كل من: الخط الخارج

  Subselection Toolأداة التحديد الفرعي  .2

 كل عن طريق مقابض التحكمتعديلات على الش يمكنك بواسطتها إجراء

مثال : ارسم دائرة حمراء وقم بتحويلها الى قلب

Free Transform. أداة التحويل الحر 3

 تدوير في تستخدم كما ، المحدد العنصر وتصغير تكبير في الأداة هذه تستخدم

يتم التحكم  يالشكل . وفى الوضع العاد وعن طريقها يمكن تغيير حجم العنصر

أثناء  Alt التحكم فى الإثنين معا اضغط لحدين الأيمن أو الأيسر وإذا أردتبأحد ا

 .والسفلى عمل ذلك , وكذلك الأمر بالنسبة للحدين العلوى

اما اذا وضعنا مؤشر الماوس على احد الحدود و ليس الزوايا فإنه يصبح بشكل 
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سهمين منزلقين مما يسمح بعمل انحراف بالشكل

التي تستخدم لعمل تعبئة متدرجة لشكل.   Gradient Transform Toolالأداة أداة ثانية هي  كما يوجد ضمن هذه

 مثال:

يمكن بعد رسم شكل وتعبئته بلون متدرج ان نتحكم بالتدرج من خلال هذه الأداة. فبو رسمنا دائرة واخترنا لها تعبئة 

 الي:متدرجة ثم اخترنا هذه الأداة وحددنا الدائرة تظهر بالشكل الت

حيث ان :

Center Point    :وهى مركز الوسط للتدرج  

Focal Point   :البؤرة أو أقصى تركيز لبقعة الضوء , وهذه النقطة موجودة فقط فى وهى تعكس Radial Gradient

. نهمايمكنك بالطبع تغيير موضع أى م وفى الحالة الافتراضية تكون هاتان النقطتان معا فى المركز تماما . ولكن

Width   :تغيير عرض التدرج

 :Size التدرج تغيير حجم 

 :Rotation تدوير التدرج  

أداة التدوير ثلاثي الابعاد .4

هذه الأداة تتألف من جزئين يمكن عرضهما من خلال الضغط المستمر على الأداة حيث يظهر قائمة فرعية تحتوي 

 هما: فرعينعلى 

 3أداة دوران ثلاثية الأبعادD Rotation Tool  :تدوير مقاطع الفيلم  Movie Clips  .في مساحة ثلاثية الأبعاد

باللون الأحمر،  Xعلى المسرح. عنصر التحكم  يظهر عنصر تحكم دوران ثلاثي الأبعاد أعلى الكائنات المحددة

 باللون الأزرق. Zأخضر، والتحكم  Yعنصر التحكم 

) سيتم شرح الرموز لاحقا بالتفصيل (  movie clipه الى رمز من نوع لتطبيق هذه الأداة يجب بعد رسم الشكل ان نحول

 ولكن الان لغرض توضيح الأداة سنطبق المثال التالي:
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 مثال:

و نحدد نوعه   convert to symbolثم   Modifyباختيار  movie clipمن نوع  ارسم مستطيلا وقم بتحويله لرمز

movie clip  م و نغير الاسم اذا اردنا ذلك ثok

فيصبح المستطيل بالشكل: 3D rotation toolاختر أداة 

تظهر دائرة في وسط المستطيل تمثل المحورين السيني و الصادي، بينما محيط الدائرة الداخلية يمثل محور ع )البعد 

 الثالث(

يمكن عمل تدوير للشكل حول أي محور بالضغط على المحور و تحريك الماوس 

zمثال: تحريك حول محور ع  yمثال: تحريك حول محور ص  xحول محور س  مثال: تحريك

اثناء التحريكاثناء التحريكاثناء التحريك

ائية النتيجة النهالنتيجة النهائية النتيجة النهائية 
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اما اذا حركنا محيط الدائرة الحمراء الخارجية نحصل على الشكل التالي:

و كنتيجة نهائية يصبح بالشكل  

  3د  ثلاثية الأبعا التحويلأداةD Translation Tool نقل مقاطع الفيلم :Movie Clips  في الفضاء ثلاثي

، تظهر على المرحلة على رأس الكائن. X ،Y ،Zالمحاور،  ع الأداة، الثلاثةالأبعاد. عند تحديد مقطع فيلم م

أزرق. المحور هو Zالأخضر، و  Yأحمر، المحور  Xالمحور 

Tool Lasso. أداة الحبل 5

 الحر التحديد عمليات إجراء أجل من الأداة هذه تستخدم و Lasso الحبل أداة باستخدام التحديد عمليات إجراء أيضا تستطيع

العمل مسرح على الموجود العناصر ولإحاطة)غير المنتظم( 
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.الأداة بهذه المرتبطة Polygon المضلعات معالج استخدم اخرى نقطة إلى نقطة من تحديد عمليات لإجراء و

 أداة التحديد السحرية:

 modifyثم تحويلها لشكل من خلال تستخدم لتحديد مناطق من الصورة ذات لون معين و لتطبيقها نقوم بفتح صورة 

 ثم نستخدم الأداة بالنقر على منطقة ذات لون محدد لتحديدها breakapartثم 

 مثال:

وحدد الصورة import to stageثم   importثم Fileادرج صورة  من خلال 

 breakapartثم  modifyاختر الامر 

 غييره الى لون اخرحدد لونا بالصورة باستخدام أداة العصا السحرية وقم بت
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 ToolPen القلم. أداة 6

 القلم أداة باستخدام .أخرى إلى نقطة من والمسارات والأشكال الخطوط برسم التحكم على القدرة Pen القلم أداة لك تتيح

Pen يقوم جهته ومن والمنحنيات، الزوايا نقاط بإضافة النقر طريق عن المسار برسم تقوم فإنك Animate بتوصيل 

 .النقاط

: تشمل خيارات عدة على القلم أداة تحتوي

 مثال :

قطع مستقيمة رسم رسم نجمة من خلال 

نضغط مع السحب لرسم المنحنى  Pen toolو لرسم منحنيات من خلال 
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 ToolText  النص . أداة7

  تعديل يمكنك فإنه نص، عنصر بإنشاء تقوم وعندما .  فلاملاا من ديناميكي جزء عن عبارة دائما هي النصوص عناصر

 خصائصه من لوح الخصائص الذي ينظم الخصائص المختلفة للنص ضمن فئات مطوية هي الفئات المشار اليها في الرسم

 ويهمنا منها ثلاثة فئات هي:

كما في الشكل التالي: التي نستطيع منها تحديد نوع الخط وحجمه و نمطه و لونه  Characterفئة  .1

: لاختيار محاذاة النص كما في الشكل التالي paragraphفئة  .2

لاضافة الفلتر ) علامة +(    add filtersوهي عبارة عن تأثيرات يمكن تطبيقها على النصوص حيث نضغط على زر filtersفئة .3

.المطلوب ومن ثم تغيير خصائص الفلتر من قأئمة خصائص
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 ToolLine  الخط . أداة8

 لرسم الخطوط .وبالطبع كما فى أغلب برامج الرسم اضغطتستخدم هذه الأداة 

Shift  ولهذه الأداة  . 45أثناء الرسم لجعل الخط أفقيا أو رأسيا أو بزاوية

تظهر في الشكل المجاور:   Properties لوح يف خيارات

 لون الخط .1

 سمك الخط .2

، شرطات(نمط الخط )متصل ، منقط .3

 ToolRectangle  المستطيل . أداة9

تحتوي هذه الأداة على عدة تفرعات تظهر عند الضغط باستمرار على هذه الأداة وهي موضحة بالشكل التالي:

. Rectangle Tool ستطيلالم رسم أداة .1

Rectangle Primitive Tool  )خام(  نستطيل ككائالم رسم أداة .2
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وعند اختيار جل إنشاء مستطيلات أو مربعات تتألف من لون خارجي و لون تعبئة )او احدهما فقط(. من ااول أداة تستخدم 

 أي شكل و رسمه يمكن تغيير خصائصه من لوح الخصائص التالي:

 لون الخط الخارجي .1

 لون التعبئة .2

 سمك الخط الخارجي .3

نمط الخط )متصل ، منقط ...( .4

ويوجد عند هذا الامر دبوس او مشبك  حيث ان القيمة صفر تعني زاوية قائمة ادخال قيمة تدوير زوايا المستطيل .5

ويوضح الشكل التالي عدة مستطيلات بعدة قيم لدوران الزاوية المدخل في المربعات  لربط هذه القيم معا او فصلها

 الأربعة.

و الشكل التالي يوضح مجموعة مستطيلات مرسومة بقيم مختلفة لتدوير الزوايا

 ToolOval  البيضاوي أداة .10

 . Oval Tool البيضاوي الشكل رسم أداة .1

Oval Primitive Tool  )خام( ي ككائنالبيضاو الشكل رسم أداة .2

Shiftتستخدم الأداة الأولى لرسم شكل بيضاوي او دوائر منتظمة اثناء الرسم بالضغط المستمر على زر 

في   oval optionsفي جزء   inner radiusات من خلال تغيير قيمة كما يمكن استخدامها لرسم دوائر تشبه الإطار

end angleو  start angleمن خلال تغيير  جزء الخصائص ، او رسم دوائر غير مكتملة ) انصاف دوائرـ ارباع ....(
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امثلة : 

 end angle = 90دائرة مع start angle = 90دائرة مع inner radius = 20دائرة مع 

( فإنهما تقومان برسم الاشكال ككائنات يتوحد فيها الخط primitives) )خام( اما اداتي البيضاوي والمستطيل ككائنات

ا تسمحان برسم الشكل كم الخارجي مع لون التعبئة ولا يكونان منفصلين مثل اول اداتين )المستطيل والبيضاوي العادي(.

 الاولي مع إمكانية تغييره من نقاط التحكم المحيطة بالشكل.

ارسم المستطيل التالي Primitive rectangle toolمثال: مستخدما أداة 

ضع الماوس على النقاط الزرقاء في زوايا الشكل و قم بالتحريك مع النقر فتلاحظ ان الشكل يتغير معك حسب حركتك 

 ح بالشكل مثلا يصب
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Polystar. أداة المضلع/ النجمة 11

إنشاء إما المضلع أو النجوم حيث يمكنك تعيين عدد النقاط التي تريدها بالضغط على زر تستخدم أداة بوليستار من اجل 

options من  لخصائص ليظهر المربع التالي الذي نحدد فيهفي لوح اstyle عدد  الشكل الذي نريده )مضلع/نجمة( ثم

 .number of sidesمن قائمة  الاضلاع للمضلع او عدد رؤوس النجمة

 ToolPencil قلم الرصاص . أداة12

 باستخدام تلوينها يمكنك التي الخارجي التحديد خطوط أو الحرة الخطوط لرسم تستخدم حيث الرصاص القلم تشبه وهي

 )الحبر( المداد علبة

 مثال :

 ام أداة قلم الرصاص كما في الشكل المجاور ارسم خطا باستخد

وعند وضع الماوس بعد اختيار أداة التحديد )السهم الأسود( على حافة الخط يمكن سحبه لتحويله الى خط 

 منحن 

 بالشكل

تلقائيا وعند رسم شكل قريب من الدائرة يقوم البرنامج برسمه كدائرة منتظمة

ص:خيارات الأداة في جزء الخصائ
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، ومن قائمة في جزء الخصائص الخاص بالاداة  strokeيمكن تغيير عرض الخط من خلال 

width   نختار عرض متغير لخط الرسم حيث تظهر الخيارات

مثال:

 ويوجد في اسفل شريط الأدوات خيار لتنعيم خط الرسم او جعله حادا كما يظهر في الشكل

 : خيارات 3وهى 

 : Straighten وهى ميزة  , يشبه الخطوط المستقيمة ترسمه إلى أقرب ما يحول البرنامج ما

الدائرة أو المربع أو المستطيل  ترسمه من أشكال هندسية مثل الخط المستقيم أو هامة لذلك الخيار حيث أن ما

لا بيضاويا جرب أن ترسم بالقلم الرصاص شك , إلى أشكال منتظمة ودقيقة Animateبشكل غير دقيق يحوله 

 منتظم ييحوله إلى شكل بيضاو Animateوسترى أن 

 Smooth  :ترسمها وتحسين الانحناءات فيها ييقوم البرنامج بتنعيم الخطوط الت .

 Ink  :تعديلات من البرنامج يترسمه يظهر كما هو دون أ هنا ما . 
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 Paint Brushفرشاة الرسم أداة  .13

، كما هو  Pattern Brushesو  Art Brushesإمكانية استخدام فرش   Animateجديدة في ال Paint Brushتوفر أداة 

على حدود الشكل وتختلف عن أداة  Paint Brushتعتمد أداة  Animate، ضمن  Adobe Illustratorشائع في 

Brush .الموجودة 

اة الفنية المحددة على المسار المرسوم. رسم حدود فرشاة منمقة من خلال تطبيق نقش الفرش Paint Brushتتيح لك أداة 

لرسم مسار وتطبيق جرة الفرشاة  Paintbrushيمكنك تطبيق جرات الفرشاة على المسارات الموجودة ، واستخدام أداة 

 وتعتبر هذه الأداة احدث واشمل من أداة قلم الرصاص السابقة. في نفس الوقت أو تخصيص ناتج تنعيم صورتك.

ن منها هما:يوجد نوعين أساسيي

 Art Brushesالفرشاة الفنية  .1

هي مجموعة من الفرش المتوفرة في مكتبة الفرش التي 

في  Brush libraryتحها بالضغط على زر  فنستطيع 

 Paint Brushداة اص بألوح الخصائص الخ

التالي: Brush Libraryوعند الضغط على هذا الزر يتم فتح مربع 
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و تصبح جاهزة    styleالى قائمة على احدى الفرش في الجزء الايمن سيتم اضافة هذه الفرشاة فقط  ر المزدوجو عند النق

  ، اما اذا ضغطنا ضغطا مزدوجا على اسم مجموعة الفرش في الوسط سيتم اضافة كل الفرش الموجودة فيهاللاستخدام

 Artمن نوع  وفيما يلي نماذج مختلفة للفرش styleالى قائمة 

اختيار احد هذه الاشكال ان نرسم مستطيل او دائرة ليصبح حد السمتطيل او الدائرة بهذا الخط الذي تم  كما يمكن بعد

 اختياره

 Pattern Brushesفرشاة النمط  .2

لمسبقة لفرشاة تتوفر مجموعة من الإعدادات ا  تستخدم لرسم عدة اشكال )أنماط( مكررة من ضربة الفرشاة بشكل متتالي.

 Pattern Brushesضمن فئة  بشكل افتراضي داخل مكتبة الفرشاةالنمط 

و التي ستصبح مكتظة بالفرش، لإزالة الفرش منها   styleأي من هذه الفرش سيتم اضافتها تلقائيا الى قائمة بعد اختيار 

 نقوم بما يلي :
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manage paint brushesنضغط زر  .1

 المجاورةتظهر النافذة التالية   .2

عند الفرش المراد ازالتها ثم نضغط  نضع إشارة 

delete

ليتم حذف كل الفرش مع   select allكما يمكن ان نختار  

الانتباه الى انه اذا كانت احدى الفرش مستخدمة حاليا على 

المسرح لن يتم حذفها 

 ToolBrush الفرشاة . أداة41

الحالي. وعند اختيار الأداة تظهر   fillباستخدام الفرشاة بحيث يكون لون الرسم هو لون  تستخدم هذه الأداة لرسم الاشكال

 كما يظهر في الشكل التالي:  propertiesخصائصها في لوح 

رأس الفرشاة. التي تضم اشكال المجاورةلاختيار شكل رأس الفرشاة تظهر القائمة   brushبالضغط على 

داة الفرشاةالخيارات التالية لأفل شريط الأدوات كما يوجد في اس

يمكن اختيار طريقة الرسم بالفرشاة )النمط( من احد الأنماط  التالية:
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Bone toolأداة العظمة  .51

هي طريقة لتحريك كائن أو مجموعة من الكائنات فيما يتعلق ة العظام: الكينماتيكا العكسية داا

نية مفصلية من العظام. هذه الأداة تسمح لك لإضافة العظام لمجموعة ب ببعضها البعض باستخدام

خدم في الرسوم المتحركة خاصة عندما نتعامل مع ستت، ومن الكائنات فيما يتعلق بعضها البعض

يه من والمفاصل مثل حركة الشخصيات الكارتونية متضمنة حركة الأيدي و الأرجل بما تحت

لك حركة الألات مثل الأوناش و غيرها و أداة العظام تساعدك حركة للمفاصل أثناء تحركها و كذ

 .على توفير كثير من الوقت و الجهد عن تنفيذ نفس الحركات بإستخدام الطرق الأخرى للتحريك

وهذه الأداة تتكون من اداتين فرعيتين هما :

1. Bone tool    2  .Bind tool   

وسيأتي شرحها التفصيلي في جزء الحركة.  
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  Paint Bucket Toolداة التعبئة. أ61

تتكون هذه الأداة من فرعين هما:

 Paint Bucket أداة التعبئة .1

نختاره من جزء الخصائص جديد بلون للعنصر الداخلي التعبئة لون لتغيير Paint bucket التعبئة لون أداة تستخدم

 :تصندوق الأدوا فى أسفلت خيارا عدة وله

1.  :Don’t Close Gapsالفجوات لإغلاق  ً  .يدويا

2. Close Small Gaps :الصغيرة الفجوات إغلاق. 

3. :Close Medium Gaps المتوسطة الفجوات لإغلاق.

4. :Close Large Gapsالكبيرة الفجوات لإغلاق. 

  Ink Bottleأداة زجاجة الحبر .2

إلى المثال التالي لدينا خط  نظرتستعمل لإجراء أى تعديلات على أى خط من حيث اللون أو الحجم أو النمط .. إلخ , ا وهى

 . مرسوم بالقلم الرصاص ثم قمنا بتغيير لونه ونمطه

. لأي شكل Stroke أو خط خارجي Pencil أو أداة Line خط مرسوم بأداة إذن هذه الأداة يمكنها إجراء تعديلات على

 styleو النمط من   Strokeو نختار اللون من لون 
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لشكل المجاور مرسوم على المسرح مثال: لو كان لدينا ا

له نقوم باختيار اللون الجديد و النمط أولا ثم نستخدم أداة زجاجة الحبر وننقر على الحد   strokeواردنا تغيير لون او نمط 

ليصبح بالشكل الجديد مثلا strokeالخارجي الحالي 

 r Eye Droppe. أداة القطارة71

 الحدود خط وخصائص اللون تعبئة حيث من آخر، عنصر إلى عنصر خصائص لنسخ Eyedropper القطارة الأداة تستخدم

Stroke الجديد العنصر على مباشرة الخصائص هذه ،وتطبيق.

. Eyedropper Tool القطارة أداة أختر .1

 إلى المؤشر فيتغير .به الخاصة الحدود خط خصائص أو الملء خواص اكتساب نريد الذي العنصر فوق المؤشر نحرك .2

.التالي الشكل

 تلوين من نتمكن حتى Paint Bucket الأداة إلى المؤشر فيتحول العنصر، لهذا اللوني التعبئة لاكتساب المؤشر نضغط .3

 .نريد الذي العنصر

يه.إل التعبئة خصائص نقل فيتم إليه، الخصائص نسخ نريد الذي العنصر على نضغط .4

. الممحاة81

  خيارات عدة ولها فيها، المرغوب غير العناصر إلغاء المسح بعملية للقيام Erase Tool الممحاة أداة تستخدم

و يقوم عند الضغط عليه بعرض عدة طرق لطريقة عمل الممحاة هي: .الممحاة نمط .1
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 . ةبنقرة واحد Stroke أو خط خارجي Fill لمحو ملء: Faucetر الصنبو معالج .2

د الضغط عليه تظهر الاحجام الظاهرة في الشكل المجاور للممحاة،عن .الممحاة وحجم شكل .3

نختار منها الحجم المطلوب 

ملاحظة : لتفريغ المسرح من محتوياته )حذف كل العناصر الموجودة عليه( ننقر على الممحاة نقرا مزدوجا

Variable Width tool. أداة العرض المتغير 19

ود من خلال إضافة عروض ذات سمك متفاوت. يمكن بعد ذلك حفظ العرض المتغير على هيئة تتيح لك أداة العرض تجميل حد

ملفات تعريف العرض التي يمكن تطبيقها على حدود الشكل الأخرى. عندما تقوم بتمرير الماوس فوق حد مع تحديد أداة العرض 

عرض الحد ، ونقل نقطة العرض ، ونسخ نقطة ، تظهر النقاط )نقطة العرض( على الحد بمقابض )مقبض العرض(. يمكنك ضبط 

العرض ، وحذف نقطة العرض. يتم عرض معلومات العرض في لوحة المعلومات عندما تقوم بتعديل عرض حد.

 يمكنك أيضًا تحديد نقاط عرض متعددة ، وتنفيذ أي من الإجراءات )النقل أو النسخ أو الحذف( المذكورة سابقاً.

ة العرض بضبط الحد النشط فقط. إذا كنت تريد ضبط حد ، فمرر الماوس فوق الحد باستخدام أداة لضربات متعددة ، تقوم أدا

العرض.

 إلى حد ما ، قم بما يلي:متغير  لإضافة عرض

line ارسم ضربة أو شكل باستخدام أي من الأدوات. على سبيل المثال ، أداة الخط• 

 .حدد أداة العرض من لوحة الأدوات 

داة العرض ، مرر الماوس فوق الحد. يعرض هذا نقاط العرض المحتملة ومقابض العرض. تقوم الأداة أيضًا بتغيير مع تحديد أ 

مظهرها مشيرة إلى أن أداة العرض نشطة ويمكن تطبيق العرض المتغير على الحد
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 .مع تحديد النقطة باستخدام أداة العرض ، اسحب مقبض العرض للخارج

  العرض المتغير يضاف إلى الحد. حدد أداة العرض ومرر الماوس ، وهذا يعرض نقطة العرض الجديدة يمكنك أن ترى أن

ومقبض العرض.

بالشكل التالي  lineاذا رسمنا خط باستخدام أداة  مثال:    

يمكن باستخدام أداة العرض المتغير ان نشكله بعدة اشكال كما يلي:



2024قسم تكنولوجيا المعلومات / خضوري اعداد: أ.أوس رحال

29

معين   strokeبعد تطبيق العرض المتغير على حد 

 widthضمن قائمة   widthيمكن حفظ هذا العرض 

التي تظهر في جزء خصائص بحيث نستطيع تطبيقها 

على حدود أخرى بمجرد اختيارها من القائمة كما  يلي:

 قمت بإضافة عرض متغير إليه حدد الخط الذي .1

( stroke)باداة التحديد حدد 

انقر فوق الزر + الموجود على يمين القائمة   .2

.Propertiesفي  Widthالمنسدلة 

في مربع حوار ملف تعريف العرض المتغير،  .3

new1الجديد مثلا  ملف التعريفلأدخل اسم 

 انقر فوق "موافق" .4

 الأسفليتم إضافة هذا العرض الى القائمة في  .5

( يتم حذف Cملاحظة: عند الضغط على رز استعادة )

 كل العروض المتغيرة المحفوظة مسبقا 

  Hand Tool)اليد( . أداة الكف20

الجرافيكس والوظيفة واحدة وهى تحريك منطقة العمل , وإذا كنت تستعمل أى أداة  هذه الأداة موجودة فى أغلب برامج

 . فى لوحة المفاتيح Space Bar مؤقتا بالضغط علىيمكنك استحضار هذه الأداة  أخرى

. Fit to Screen مناسب للرؤية بشكل كامل وعند النقر المزدوج عليها تصبح منطقة المسرح بحجم

لتدوير المسرح كاملا  Hand Rotation Toolكما يوجد فيها أداة 

  ToolZoomالتكبير/التصغير . أداة 12

. Alt بالضغط على ة التكبير أو التصغير , ويمكنك التحول بين الوظيفتين مؤقتاوظيفتان لهذه الأدا يوجد

 %100بة على تكبير للمسرح بنس بالنقر المزدوج على الأداة تحصل

 . Fillتحديد لون الملء. لStroke .   32حديد لون الخط الخارجي. لت22

 ابيض/اسود.  42

. Stroke الخارجي سود للخطوالأ Fill الأبيض للملء

 . عكس الالوان 52

لوني التعبئة و الخط الخارجيالأيقونة الثالثة لعكس 
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Adobe Animateالالواح في 

ية:التال الألواح وإخفاء إظهار يمكننا خلالها منالتي  و الألواح وإخفاء إظهار نافذةيظهر في الشكل المجاور 

   Color  بالألوان التحكم لوح  1.

 Color Swatches  الألوان تبديل 2. 

  Align المحاذاة  3.

  Info  المعلومات نافذة  4.

  Transform تحويل 5. 

6. Motion Preset 

 تعرف ان من بد لا لذلك .تحتاجها لا وأخرى معينة مرحلة في العمل أثناء تحتاجها التي  Panels الألواح بعض توجد

.الحاجة حسب لواحالأ هذه وإخفاء إظهار طريقة

:الألواح ظهارلإ

 قائمة أفتح Window . 

 ص الخصائ لوح مثلا إظهاره تريد الذي اللوح اختر Properties

 إشارة ظهور تلاحظ  اللوح أمام. 

:الألواح إخفاء

 قائمة أفتح Window . 

 الادوات شريط مثلاُ  إخفاءه تريد الذي اللوح اختر Tools )

 إشارة اختفاء تلاحظ  اللوح امأم. 

:   Colorالألوان لوح استخدام

 كما الداخلي، اللون أو الحد لون تحرير أو لتعيين آخر أسلوب عن عبارة هو

 اختيار وعند ، Alpha خاصية من اللون شفافية درجة في التحكم تستطيع

 بها نقوم التي التعديلات تطبيق يتم سوف العمل، مسرح على العناصر أحد

  .العنصر هذا على مباشرة وحالل هذا خلال من

 الخط لون .1

 التعبئة لون .2

زر ابيض و اسود )اسود للحد و ابيض للتعبئة( .3

 لون بلا .4
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 )تبديلهما( التعبئة واللون الحد لون عكس .5

 المعاينة نافذة .6

 عشر السادس بنظام اللون قيمة حقل .7

 الإضاءة ضابط .8

 الشفافية درجة .9

  ( R, G ,B ) المحدد اللون قسم .10

والذي يوجد له عدة خيارات موضحة بالجدول التالي: ةالتعبئ لون نمط .11

 الألوان...حول  ملاحظة

نظام الألوان الثلاثي )الأحمر ، الأخضر، الأزرق(  باستخدام ستة رموز، وهي  حسب Animateيعبر عن أي لون في  

 -مكتوبة بالصيغة التالية:

درجة لونية ويعبر عن هذه الدرجات  256هناك ثلاثة ألوان أساسية هي الأحمر والأخضر والأزرق، ولكل منها يوجد 

 . ومن خلال مزج هذه الألوان بدرجاتها اللونية المختلفة نحصل على الألوان الأخرى. 255وحتى  000بالأرقام من 

من هذه الألوان الثلاثة * -وبنسبة معينة من الدرجات-ن هو مزيج * إن أي لو
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من كل من اللون الأحمر والأخضر والأزرق. واللون الأبيض مكون من  000فمثلا اللون الأسود مكون من الدرجة 

ون الأخضر، لل 255للون الأحمر، والدرجة  255من هذه الألوان. أما اللون الأصفر فهو مكون من الدرجة  255الدرجة 

 من اللون الأزرق... وهكذا بنفس الطريقة يتم تكوين باقي الألوان.  000والدرجة 

ينتج لدينا أن عدد الألوان التي يمكن الحصول عليها بمزج الألوان الثلاثة  256×256×256وبعملية حسابية بسيطة 

 بالضبط.  16777216السابقة هو 

مكتوبة بالنظام … تي عبرت عن اللون الأبيض بها. إنها ببساطة أرقاموال FFFFFFحسنا، لكن من أي جاءت الرموز 

 A,B,C,D,E,Fوالرموز  9إلى  0ويعبر عنه باستخدام الأرقام العادية من  16السداس عشري )نظام عددي أساسه الرقم 

 بالنظام السداس عشري. FFبالنظام العشري العادي يكافئه الرقم  255(. فالرقم 

من  255في الوسط يمثل الدرجة  FFللون الأحمر. والرقم  255على اليسار يمثل الدرجة  FFس عشري إذن فالرقم السدا

 من اللون الأزرق.  255على اليمين يمثل الدرجة  FFاللون الأخضر. والرقم 

أما اللون الأسود فرقمه هو  6699CCوعلى هذا المنوال يعبر عن اللون الأزرق الفاتح بالرقم السداس عشري: 

000000 . 

وهذا جدول ببعض الألوان ورموزها المكافئة بالنظام السداس عشري. 

ABCDEF FFFF00 

FEDCBA 336699 

773466 112233 

FF1122 666666 

0033FF 663333 

AABBAA 00FF00 

800800 FF6600 

008008 993366 

020769 123456 

111111 654321 

أما كيف تعرف الرمز الخاص باللون الذي تريد اختياره، فيوجد برامج خاصة تستطيع من خلالها دمج الألوان الثلاثة  

بنسب مختلفة، ومن ثم يقوم البرنامج بتوليد الرمز السداس عشري المكافئ للون الناتج. 

Animateفي  الرسمملاحظات حول 

: ملحوظات 3سم الأشكال لدينا ينبغ أن نذكر أنه بالنسبة لر هنا
 : 1ملحوظة رقم 

الاعتبار أننا حين نرسم أى من الأشكال العديدة  أن نأخذ فى  يجب

يكون عبارة عن عنصرين منفصلين , الأول خط   السابق ذكرها , فإن الشكل
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ديد كلا العنصرين , بالنقر يجب تح -لتحريكه مثلا  -وعند تحديد الشكل  , Fill يملء داخل يوالثان Stroke تحديد خارجى

 Fill & Stroke وهى تتكون من عنصرين على الشكل .انظر للصورة التالية وفيها شكل عبارة عن دائرة المزدوج

: الصورة التالية حاولنا تحريك أى عنصر منهما بمفرده نلاحظ أنه يتحرك بمعزل عن العنصر الآخر كما فى ولو

نستطيع تحديد  وبذا , Group ذه المشكلة تحديد كلا العنصرين ثم تحويلهما معا إلى مجموعةأيضا لحل ه ويمكن

. Modify > Group      ( Ctrl+G )  . الشكل فقط بنقرة واحدة

 : 2ملحوظة رقم 

من الشكل ونريد تحريك الشكل العلوى فإنه يقتطع جزءا  فى الإصدارات السابقة عندما يكون لدينا شكلين فوق بعضهما

الأولى ثم الصورة الثانية عندما حاولنا تحريك الشكل العلوى أسفل منه . انظر إلى الصورة

الملء , ثم جعلت أحد الشكلين يتلامس مع  ولهما نفس لون Stroke والأدهى من ذلك حين كنت ترسم شكلين ليس لهما

 ! قطعة واحدة الشكل الآخر فإن الشكلان يمتزجان ويصبحان

فى  هذه الأيقونة أثناء رسم الأشكال بالنقر على -أو الإبقاء عليها  -الآن صار بوسعك إلغاء هذه الخاصية 

 . J أسفل صندوق الأدوات , أو من لوحة المفاتيح اضغط Options قسم

محددا  وترى أن الشكل الذى ترسمه يكون , Object Drawing Modeالأيقونة فإنك تصبح فى وضعية لنقر علىعند ا

 : بإطار كما فى الصورة التالية
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المزدوج نستطيع رؤية كلا  وبالنقر , Group ليه , مثلما الحال فى وضعلاختيار الشكل نحتاج لنقرة واحدة ع الآن

  Fill و Stroke العنصرين

أثناء تحريك الشكل بأداة   Altمن شكل وذلك بالضغط على مفتاح -أو عدة نسخ  - يمكنك عمل نسخة:  3ملحوظة رقم 

 التحديد
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 Timeline خط الزمن

برامج الجرافيكس الأخرى أنه يقوم أساسا على فكرة حركة العناصر والأشكال  عن Animateيميز برنامج  إن أهم ما

ولتبسيط الأمر  , يعج بالأشكال المتحركة والعناصر المتفاعلة Animateيكون عبارة عن فيلم  يوالناتج النهائ , بداخله

طات المتتابعة والمرقمة إذا أمسكت به اللق عبارة عن شريط طويل من يهو مثل أى فيلم سينمائ Animateتخيل أن فيلم 

والتى تليها أختلافا طفيفا لا تكاد تلحظه , ولكن عند تحريك هذا الشريط أمام  بيديك ونظرت إليه , ستلاحظ أن بين كل لقطة

  . فى السينما بسرعة سنرى العناصر تتحرك أعيننا

 Timeline الأقسام الهامة فى البرنامج وهو أحد, سنقوم بمعرفة  Animate يولكى نتعرف على كيفية إنشاء الحركة ف

 أو خط الزمن

 : إلى قسمين رئيسيين هما Timeline تنقسم منطقة

 . منذ قليل هى تماثل مفهوم اللقطات الذى تحدثنا عنه:و  Frames لإطاراتا .1

جودة فى مسرح وتنظيم العناصر المختلفة والمو ووظيفتها كما هو واضح من إسمها هو فصل: Layers لطبقاتا .2

يسهل التعامل معها بشكل أدق وبدون التأثير على العناصر فى الطبقات  العمل وتوزيعها على طبقات متعددة بحيث

. الأخرى

الشكل التالي يوضح جزء الطبقات وخط الزمن.

وعند  ،تلك المنطقةنتعرف بشكل أكبر على محتويات  وتعالوا جانبا ونركز على منطقة الإطارات والآن لنترك الطبقات

 يكالتال فتح البرنامج وبداية العمل ستبدو
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1. Onion Skin الوقت نفس في العرض نافذة داخل الإطارات محتويات لمشاهدة. 

2. Onion Skin Outliner العرض نافذة داخل فقط رسم كخطوط الإطارات محتويات لعرض

3. Edit Multiple Frames الإطارات محتويات لتحرير. 

4. Modify Onion Markers محتوياتها عرض المراد الإطارات عدد لتحرير. 

 . رقم الإطار المعروض حاليا .5

وفى الوضع  , Frame per second (fps) أو سرعة الفيلم , ويتم قياسه بعدد الإطارات فى الثانية الواحدة .6

لاتشغل نفسك بهذا الأمر  وبالطبع يمكنك تغيير تلك السرعة ولكن . إطار فى الثانية 24الإفتراضى تكون القيمة 

 . حينه الآن , سنذكر ذلك فى

. الوقت المنقضى حتى الإطار المعروض حاليا ويقاس بالثانية  .7

تراه حاليا هو طريقة العرض  والذى Timeline بالنقر على السهم الصغير يمكنك اختيار شكل عرض .8

   Normal  الإفتراضية

وهذه الخيارات هي:  Animateهناك عدة طرق لعرض خط الزمن في 
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وترى أمامك الآن شريطين الشريط السفلى هو  , يأتى الآن أهم جزء فى منطقة الإطارات وهو بالطبع الإطارات نفسها

 لتوضيح أرقام الإطارات , وترى أمامك الجزء الأحمر المسمى ب شريط الإطارت , والعلوى وبه تدريج وأرقام

Playhead الحين  د الحركة المتتابعة للإطارات وتستطيع القيام بهذا الأمر لتختبر فيلمك بينفإنك تشاه وعند تحريكك له

 والآخر بشكل سهل وسريع

معرض حديثنا عن الإطارات , انظروا إلى  إلى هنا ويبدو أن كل شيئ واضح وسهل , ولكن يتبقى أهم وأخطر جزء فى

؟ ولماذا يتميز عن الإطارات التى تليه  Blank Keyframe إطار مفتاحي فارغ, لماذا قمت بتسميتة بـ 1الإطار رقم 

 . يوجد أى عناصر فى الإطار ) أو اللقطة ( ؟ طالما أننا لانزال فى البداية ولا

.اتتعالوا لنتعرف على أنواع الإطارلكى يتضح الأمر 

 أنواع الاطارات

Frame , Keyframe , Blank Keyframe ?

يكون فارغا لا يوجد به أى شيئ ولذا لا يحتسب فى  لى الإطار الأول , وهو نوعان إما أنهو أى إطار ي Frame ببساطة

 بقي كما هو فارغا , ويمكن تمثيل ذلك بالفيلم السينمائى الخام أو الجزء المتبقى من زمن الفيلم الذى سنقوم بعمله طالما

المونتاج فى السينما بإقتطاع هذا الجزء  ه , حيث يقومشريط الفيلم الخام الذى لم نستعمله بعد ولم يتم تسجيل أى شيئ علي

  . من الفيلم والإلقاء به فى سلة المهملات

منها هو إطالة المدة الزمنية لوجود تلك العناصر ,  والنوع الثانى هو أطار به عنصر أو عناصر ولكنها ساكنه , والهدف

ولكنه يستمر فى التواجد فى اللقطات التالية من المشهد دون أدى دوره المطلوب منه  ولتوضيح ذلك يمكن تشبيه ذلك بممثل

  . حركة , أى مجرد ظهور لوقت أطول أى

ولكنها فارغة, وربما  Frames هى إطارات 1رقم  انظر إلى الصورة السابقة , كل الإطارات التى تلى الإطار الإطار

 .إطارات الإطارات ليس إلا لكنها فى النهاية كلها إطارات وذلك لسهولة تمييز وعد 5تلاحظ أن لون الإطار يتغير كل 

وضع أى عنصر فى مسرح العمل , ويمكن تشبيه  فهو الإطار الذى يظهر عند بداية العمل وقبل Blank Keyframe أما

  . الثوانى الأولى فى مسرحية بعد رفع الستار مباشرة وقبل ظهور أى ممثلين ذلك بشكل مجازى بأنه يبدو تماما مثل

عناصر فيه بعد أن كان خاليا أو بتغير طرأ  فهو إطار يحدث به نقطة تحول ما , إما بظهور عنصر أو Keyframe أما

وفى المثال السابق بعد ثوانى من رفع الستار ورؤيتنا للمسرح خاليا نرى بداية  . على العناصر التى كانت موجودة من قبل

  . Keyframe إلى Balnk Keyframeالممثلين , فى هذه اللحظة يتحول الـ ظهور

 Animateالمحاور الأساسية لتعلم  والآن إلى مزيد من التوضيح لأن هذه النقطة هامة جدا , وهى من

 . أو : إطار مفتاحى فارغ Blank Keyframe وهو عبارة عن 1لقد قمنا بفتح البرنامج ولدينا الإطار رقم 
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. للإطار ولنشاهد ماذا سيحدثسنضع الآن عنصرا فى المسرح عبارة عن كرة 

إلى نقطة سوداء , وتحول  -بعد إضافة الكرة  -تحولت  , لاحظتم أن الإطار المفتاحى الفارغ كان به نقطة مستديرة بيضاء

 . أو : إطار مفتاحى , Keyframe إطار مفتاحى فارغ إلى أو Blank Keyframe الإطار من

. Keyframe وجود إطار مفتاحى د إجراء تغيير ما فلابد منإذن حصلنا الآن على قاعدة تقول : عن

  هكذا يبدو Keyframe إن الإطار المفتاحى

فيبدو هكذا Blank Keyframe أما الإطار المفتاحى الفارغ

هذا الأساس فإن هذا يعنى أن الكرة تظهر فى الفيلم لمدة  الآن لو اكتفينا بوجود الكرة فى الإطار الأول وصنعنا الفيلم على

ثوانى  3جب أن يزيد زمن ظهور الكرة ولنقل مثلا لمدة وهو بالطبع أمر غير منطقى , إذن ي , جزء من الثانية 12على  1

إطارا , اسحب بالزر الأيسر للماوس من  36إطارا فى الثانية فيلزمنا  12, ولو أخذنا فى الإعتبار أن الفيلم يحتوى على 

 الإطارات , لقد تم تحديد 36الإطار الأول حتى الإطار 

Insert Frame اوس واخترباللون الأزرق . الآن انقر بالزر الأيمن للم
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بالرغم أنه لم يطرا أى  - ) والتى كانت فارغة من قبل ( تحتوى الآن على الكرة 36حتى  1صارت الإطارات من  لقد

 . Frames عن طريق إضافة إطارات رة ظهور الكرة فى المشهدأى أننا أطلنا فقط فت -تغيير عليها 

 Insert Blank Keyframe واختر 37انقر بالزر الأيمن للماوس على الإطار رقم 

 . ماذا لاحظت الآن ؟ لقد اختفت الكرة من المسرح

 ( السابقه ) ربما لنضع محتويات جديدة مثلا إذن الإطار المفتاحى الفارغ نستخدمه لإفراغ المسرح من المحتويات

فى  Fill Color الكرة إلى لون آخر بالنقر على  , ثم قم بتغيير لونمثلا 10الآن قم بالنقر على أى إطار وليكن رقم 

 فقط وبالطبع هذا مالانريده أو 10لون الكرة فى كل الإطارات وليس فى الإطار رقم  الأدوات , ماذا تلاحظ ؟ لقد تم تغيير

أننا سنقوم  Animateأن نخبر  نقصده , نحن نريد إحداث تغيير عند الإطار المحدد , فمالحل ؟ , الحل ببساطة يتكثل فى

  . فى مكان الإطار المطلوب Keyframe بإدراج إطار مفتاحى بتغيير عند الإطار المحدد . وكيف نخبره ؟ : بأن نقوم

Insert Keyframe : من القائمة التى ستظهر واختر 10انقر مرة أخرى بالزر الأيمن للماوس عند نفس الإطار رقم 

  قم الآن بتغير لون الكرة , ماذا تلاحظ الآن ؟

 . وحتى نهاية الفيلم 10لقد تغير لون الكرة إبتداء من الإطار 

. إذن نقوم باستخدام الإطار المفتاحى عندما نود إجراء تغيير ما
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وفى الدروس القادمة سيتعمق لديك هذا الإدراك  , ركت الآن ماهو الفرق بين الأنواع المختلفة للإطاراتأعتقد أنك أد

 . بالتطبيقات العملية المختلفة

 نقل الإطارات

نفس الطبقة أو حتى طبقة أخرى , يمكنك أيضا  يمكنك نقل أى إطار من أى نوع , فقط انقر عليه واسحبه لأى موضع فى

 . أولا بتمرير الماوس عليهم ثم سحبهم بالماوس رات دفعة واحدة , قم بتحديدهاإطا نقل عدة

نسخ الإطارات وقصها ولصقها

 Copy واختر مايناسبك من العمليات المختلفة من نسخ سقم بتحديد الإطارات التى تود نسخها ثم انقر بالزر الأيمن للماو

 Paste المراد وانقر مرة أخرى بالزر اليمن للماوس واختر لصق ثم اذهب للموضع , Cut أو قص

بسحب الإطارات المحددة أن تضغط  كما فى معظم البرامج وبالأخص برامج الجرافيكس يمكنك وأنت تقوم:  ملحوظة

 . الآن هو وضعها فى المكان المراد مل نسخة أخرى كل ماعليك عملهلع Alt باستمرار على زر

 إلغاء إطارات

. لإلغاء الإطارات العادية Remove Frames حدد الإطار أو الإطارات ثم انقر بالزر اليمن واختر

مكانها شاغرا  ملحوظة جانبية صغيرة : يمكنك إلغاء الإطارات العادية والإبقاء على

 Clear Frames خياربواسطة ال

الإطار المفتاحى الفارغ (  ولإلغاء الأنواع الأخرى من الإطارات ) الإطار المفتاحى , أو

  Clear Keyframe اختر
 

 إنشاء إطارات أساسية

 

 :يلي مما بأي قم 

 keyframeثم  timelineثم     insertثم اختر قائمة  ط الزمنيخحدد إطارا في ال• 

insert keyframe  واخترفي المخطط الزمني  على الاطارالأيمن انقر بزر الماوس • 

إدراج إطارات في المخطط الزمني

frameثم  timelineثم     insertاختر قائمة لإدراج إطار جديد، • 
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يمكن تطبيق الأوامر السابقة على الإطارات في الخط الزمني من خلال القائمة اليمنى للماوس و الظاهرة 

  التالي و التي تحتوي الأوامر التالية: في الشكل

1. Create Motion Tween 

2.   Create Shape Tween       لانشاء الحركات و سيأتي تفصيلها لاحقا 

3. Create Classic Tween 

4.   Insert frameلاضافة إطارات عادية على الشريط الزمني : 

5. Remove frame مما يقصر من طول الحركة الحالي  : لإزالة إطارات محددة مع اقتطاعها من الفيلم 

6. Insert keyframe لادراج اطار مفتاحي رئيسي : 

7. Insert Blank keyframe لادراج اطار مفتاحي رئيسي فارغ : 

8.   Clear keyframeمسح اطار مفتاحي و لا يعمل الا على اطار به نقطة سوداء : 

9. Convert to keyframe ي مع إبقاء محتويات الاطار المفتاحي السابق : تحويل الاطار الحالي الى اطار مفتاح

 ظاهرة في هذا الاطار

10. Convert to Blank keyframe  تحويل الاطار الحالي الى اطار مفتاحي فارغ أي لا يكون تابع لما قبله و لا :

 تظهر العناصر السابقة له فيه

11. Cut frames  :بيضاء قطع الإطارات الحالية و استبدالها باطارات فارغة

12. Copy frames نسخ الإطارات المحددة وما تحتويه : 

13. Paste frames عند الاطار المحدد حاليا : لصق الإطارات المنسوخة او المنقولة 

14. Clear frames مسح محتوى الإطارات المحددة و استبدالها باطارات فارغة أي ان طول الفيلم لن يتأثر :

15. Select all framesتحديد كل الإطارات : 

16. Reverse frames عكس حركة الإطارات المحددة : 

17. Actionsفتح نافذة الاكشن سكريبت الخاصة بالاطارات : 

للإطارات اختصارات مفيدة بالنسبة

  الإختصارات المفيدة والتى سنستعملها مستقبلا إليك هذه

  F5 إدراج إطار

 F6  إدراج إطار مفتاحى

  F7 إدراج إطار مفتاحى فارغ

مع المفتاح المخصص Shift طارات السابقة فقط اضغط مفتاحولإلغاء أى نوع من الإ

 Symbols الرموز

أو باستخدام الزر. يمكنك  Animateالرمز عبارة عن مقطع رسم أو زر أو مقطع فيديو تنشئه مرة واحدة في بيئة تأليف 

لة لإعادة الاستخدام يمكنك الرمز مادة قابأي ان  بعد ذلك إعادة استخدام الرمز في المستند أو في مستندات أخرى.

 التفاعل.  استخدامها للتأثيرات الخاصة أو الرسوم المتحركة أو
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الرسوم المتحركة لأنه يمكن إعادة استخدامها. يمكنك استخدام من  يمكن للرموز تقليل حجم الملف ووقت التنزيل للكثير

على سبيل المثال، يمكنك تقليل حجم  واحدة فقط.بياناته مرة يخزن  Animateولكن  .مراتعددا لا حصر له من الرمز ال

ملف المستندات الخاصة بك عن طريق تحويل رسومات ثابتة، مثل صور الخلفية، إلى رموز ومن ثم إعادة استخدامها. 

 .تحميلها مرة واحدة فقطيحتاج الى  Animateمشغل لأن  ،ملفالاستخدام الرموز يمكن أيضا سرعة تشغيل 

للرمز، ويترك الأصل في  instance مثيلا Animateينشئ المسرح  في لوحة المكتبة. عند سحب رمز إلى  يتم تخزين الرموز

 المكتبة. 

التصوير الفوتوغرافي الأصلي،  كأنه نيجاتيفل هو نسخة من رمز موجود على المسرح. يمكنك التفكير في الرمز يمثال

واحد فقط، يمكنك إنشاء  نيجاتيفمع ف. صور الموجودة على النيجاتيفكالنسخ المطبوعة من الوالحالات على المسرح 

 مطبوعات متعددة.

 تحرير الرمز إلى تحديث كافة مثيلاته، ولكن تطبيق التأثيرات على مثيل رمز يقوم بتحديث هذا المثيل فقط.يؤدي 

أنواع الرموز

ثلاثة أنواع من الرموز: Animateيوجد في  

عند إنشاء الرسوم المتحركة، . كثر شيوعا، قوية، ومرنةالأهي واحدة من  (movie clip) رموز مقطع الفيلم .1

مستقل خط زمني  سوف تستخدم عادة رموز مقطع الفيلم. ومن الجدير بالذكر أيضا أن رموز مقطع الفيلم تحتوي

 ا ومنفصلة عن زمن الفيلم الأصلي.خاص به

قوم بتنفيذ مهام محددة في الفيلم كالايقاف و التشغيل  فهي وهي عبارة عن ازرار ت. (buttons) رموز الأزرار .2

صف ت وهي تحتوي على أربعة إطارات أساسية فريدة من نوعها لجعلها تفعل شيئا.اكشن سكريبت تحتاج وظيفة 

كيف تظهر عندما الماوس التفاعل معها. 

الا  رسوم المتحركةمع الدامها يمكنك استخ حيث هي النوع الأساسي من الرموز. (graphic) الرموز الرسومية .3

يمكنك تطبيق الفلاتر أو أنماط ولا  اكشن سكريبت الرموز الرسومية هي الرموز الأقل مرونة، لأنها لا تدعمان 

 المزج على رمز رسم.

:Animateطرق إنشاء الرموز في 

 ان نقوم بإنشاء الرموز من خلال طريقتين: Animateنستطيع في 

 انشاء الرمز من فراغ.. 2  كائن الى رمز تحويل شكل او .1

التحويل الى رمز   .1

المقصود هنا، هو ان يكون لدينا شكل او صورة ما على المسرح ونريد تحويلها الى رمز من اجل تطبيق عمليات التحريك 

 عليها.

 ة(يالتال قعليها احدى الطر ق)ارسم دائرة وطب: مختلفة ويمكن عمل ذلك بثلاثة طرق

أثناء صنع الفيلم مثل الرموز والصور  هى مكان لوضع كل ماتحتاج إليهالمكتبة 

للفيلم لن يتضمن سوى  وملفات الصوت والفيديو .. إلخ , والملف النهائى

ليس كل ماهو  العناصر التى تم استعمالها بالفعل على المسرح .أى بمعنى آخر

  النهائى Animateموجود بالمكتبة سيتم تضمينه داخل فيلم 
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 :ة الأولىالطريق

 Convert to symbol الأيمن للماوس ثم اختر انقر على الكائن بالزر

 :الطريقة الثانية

. من لوحة المفاتيح F8 الكائن ثم الضغط على قم بتحديد 

 :الطريقة الثالثة

 : بعد تحديد الشكل إذهب للقائمة

Modify > Convert to Symbol

: وحة التاليةستظهر لنا الل وفى كل الأحوال

بالطبع يمكنك تسميته كما يحلو  ,(Symbol 1) يمكننا إعادة تسمية الرمز بدلا من الإسم الإفتراضى Name فى مربع -

يحتوى على  Animate الأفضل أن تعطيه إسما يدل على الشكل المرتبط به , فعندما تقوم بعمل مشروع لفيلم لك ولكن من

. البعض ن المفيد تمييز تلك الرموز عن بعضهاالعديد من الرموز ستجد أنه م

: يمكننا تحديد نوع الرمز من بين أنواعه الثلاث Type وفى خانة -

Movie clip, Button, Graphic

. للخروج OK سبيل المثال . اضغط على Graphic الآن سنختار النوع

 : التغييرات التالية وعلى الفور ستلاحظ حدوث
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حيث نجد إسمه وصورته .  , Library المكتبة الرمز تلقائيا فىسيتم إضافة  -أولا

. أضلاع وإضافة دائرة صغيرة فى مركزه كما نرى 4الرمز بتحديد من  فى منطقة المسرح سيتم إحاطة - ثانيا

لنا أن نتساءل مامعنى إحاطة الرمز بتحديد ؟ حقوربما ي

: فى الحقيقة هناك فائدتين لذلك

. لتمييز الرمز عن الشكل العادى : الأولى

 كيفية تحويل الكائن إلى رمز , والحقيقة أن كلمة تحويل أو تتعلق بمفهوم الرمز , لقد ذكرنا فى بداية الدرس : الثانية

Convert إلى رمز وإنما نقوم بوضع الكائن داخل رمز , أى  حيح , فنحن لا نقوم بتحويل الكائنلا تعبر عن المعنى الص

 . نضع بداخله مانريد من كائنات Container أو حاوية أن الرمز هو عبارة عن صندوق أو وعاء

عمل بروز له وحاول تغيير شكله ب Selection Tool قم بالنقر على الرمز بأداة التحديد , ولكى أثبت لك صحة ما أقول

 . لن تستطيع إحداث أى تغيير , مثلا , ماذا كانت النتيجة

 : ستلاحظ التغييرات التالية , انقر على الرمز نقرة مزدوجة , ولاحظ ماذا يحدث

المزدوج على الصندوق  التحديد المربع حول الدائرة وصار من الممكن إجراء أى تغييرات عليها . عند النقر اختفى : أولا

 . بداخله رمز , إنفتح الصندوق وصرنا نتعامل مباشرة مع الكائنأى ال

 منفصل عن زمن المشهد ( وهو 2زمن آخر خاص بالرمز) رقم  ,( Timeline ) الزمن ظهر لدينا فى شريط : ثانيا

Scene 1 (  ويمكنك الخروج من زمن الرمز إلى زمن المشهد بالنقر على 1رقم . ) Scene 1 على السهم المتجه  أو النقر

. لليسار
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 . رموز , فإنه سيكون لكل رمز زمنه الخاص به أيضا واستنادا إلى نفس الفكرة لو كان لدينا فى الفيلم عدة

 لتوقف قليلا لفهمه , إن لوح الخصائص يصف الرمز الموجودستجد شيئا يستحق ا Properties ثالثا : فى لوح الخصائص

على المسرح بأنه

 : Instance of اسم الرمز

. أنه نظير أو نسخه عن الرمز المذكور وليس الرمز نفسه أى ,

ملاحظة هامة:

الدائرة الموجودة في المكتبة هي الرمز )الأصل(

مثيل من الرمز )نسخة(.  و نستطيع سحب عدد من النسخ  اما الدائرة الموجودة على المسرح فهي نسخة او

 كما نريد.

 ؟ ولكن مامعنى ذلك

 لإستخدامها على شبكة الإنترنت , لذا فمن Movies أفلام أو هو عمل Animateإن من بين الوظائف العديدة لبرنامج 

فكرة الرموز والنظائر . وللمزيد  رنامجالضرورى أن تكون هذه الملفات صغيرة الحجم بقدر الإمكان , لذلك فقد ابتدع الب

 : من التوضيح نقول

كيلو بايت  50ظهور ذلك الكائن مرة واحدة فى الفيلم , فسينتج لدينا فيلما لنفرض أن حجمه سيكون  لو أن لدينا كائنا وأردنا

كيلو  500م الفيلم مرات أى يصبح حج 10مرات فسيتضاعف حجم الفيلم  10مثلا , ولكن لو أردنا استخدام نفس الكائن 

 . بايت

 50فإن حجم الفيلم لن يتغير وسيظل  -نسخ  10أو  -نظائر  10رمز ثم أخذنا منه  ولكن لو قمنا بتحويل ذلك الكائن إلى

 . بايت كما هو كيلو

 . الرمزلهذا  -أو عدة نظائر  -على المسرح هو نظير  يتواجد إذن أى رمز نقوم بإنشاؤه يتواجد تلقائيا فى المكتبه , وما

انشاء الرمز من فراغ: .2

قم بأحد الإجراءات التالية:ونقصد هنا ان ندخل الى نافذة )نمط( تحرير الرمز ومن ثم انشاء الرمز فيها. وللقيام بذلك 

او .  insert>new symbolحدد   .1

او انقر فوق الزر رمز جديد في الجانب السفلي الأيسر من لوحة المكتبة.• 

 من لوحة المكتبة. الايمنحدد رمزا جديدا من قائمة لوحة المكتبة في الركن العلوي • 
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 فيظهر مربع الحوار الخاص بإنشاء رمز       

سلوك.في مربع الحوار إنشاء رمز جديد اكتب اسم الرمز وحدد ال  .2

انقر فوق موافق. .3

Animate  يضيف الرمز إلى المكتبة ويتحول إلى وضع تحرير الرمز. في وضع تحرير الرمز، يظهر اسم الرمز أعلى

 .المسرح بجانب اسم المشهدالزاوية اليسرى العليا من 

.دوات الرسمأإنشاء محتوى الرمز، استخدم المخطط الزمني، أو الرسم باستخدام قم الان بما يلزم من اجل  

للرجوع إلى وضع تحرير المستند، قم بأحد الإجراءات التالية: 5

او "رجوع". السهم الأزرق العريض انقر فوق الزر• 

 او  edit documentثم  editاختر قائمة • 

 انقر فوق اسم المشهد في شريط تحرير.• 

. يمكنك وضع محتويات و شكلها + ير الرمزفي وضع تحر لمسرحعند إنشاء رمز، يتم وضع نقطة التسجيل في منتصف ا

يتناسب الرمز في النافذة فيما يتعلق بنقطة التسجيل. لتغيير نقطة التسجيل، عند تحرير رمز، حرك محتويات الرمز فيما 

 نقطة التسجيل.مع 

صندوق فارغ  , مجرد ولكن لا شيئ آخر , لقد قمنا بإنشاء صندوق داخل الزمن الخاص بالرمزحتى هذه المرحلة، نكون 

 فلن نحصل على شيئ , مجرد مسرح خال من Animateولو قمنا بتحويل الملف الآن إلى فيلم  , ئ بداخلهلا يحوى أى ش

 . المشاهد والممثلين

مثال:

متبعا الطريقة السابقة قم بانشاء رمز بشكل دائرة.

  insert>new symbol نختار .1

graphicنختار النوع  .2

 دائرة ثم موافق نكتب اسما للرمز مثلا .3

فيتم الدخول الى نمط تحرير الرمز نرسم فيه الدائرة باستخدام الأدوات  .4

هو موضح فى الصورة للعودة إلى الزمن الأصلى  أو على السهم فى شريط الزمن كما Scene 1 الآن انقر على .5

  للمشهد

 .. ! أين ذهبت الدائرة ؟ لقد اختفت ماذا حدث ؟
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بإنشاء رمز من الصفر وهو رمز فارغ لا يحتوى على شيئ بداخله , ولأن برنامج  أننا قمناتفسير ذلك ببساطة , هو 

Animate نقوم بوضع شكل  لايرغب فى التطفل أو فرض إرادته علينا , لذلك فهو يحتفظ بالرمز فى المكتبة , وعندما

داخل المكتبة إلى أن تحين اللحظة التى أيضا  - بالتعديلات الجديده -داخل الرمز فإن البرنامج يستمر فى حفظه للرمز 

لذلك الرمز . إن  Instance المسرح , عندها يمنحنا البرنامج نسخة أو نظيرا نحتاج فيها إلى استخدام الرمز على

للفيلم , ففى المكتبة يمكننا وضع مانريد من  تكمن فى اسلوبه البديع فى تقليل الحجم النهائى Animateروعة برنامج 

النهاية لن يحتوى الفيلم النهائى إلا على العناصر التى تستخدم فى  ومقاطع صوت .. إلخ , ولكن فى رموز وصور

المخرج ومساعدوه  : تماما مثل الفيلم السنينمائى فأنت تجد فى الأستوديو أشياء كثيرة خلف الكاميرا , مسرح العمل

إلخ , ولكن الفيلم النهائى لن يحتوى إلا  .. ءةوعمال وممثلين وكومبارس وديكورات مبعثرة وأسلاك وماكينات إضا

 . .على مايظهر أمام الكاميرا

فتصبح الدائرة في المسرح.. , فقط قم بسحب الرمز إلى المسرح )المثيل( للحصول على النظير والآن

 واحد عمل عدة نظائر لرمز

. المسرح مرة تلو الأخرى ويمكنك ذلك بسحب الرمز من المكتبه إلى

  ديل فى النظائرالتع

:النواحى التعديل فى كل نظير على حدة دون أن يؤثر ذلك فى النظائر الأخرى , وذلك فى بعض يمكنك

Free Transform  - 1  تشويه لتلك الأبعاد تغيير أبعاد الكائن وعمل . 

 Color Effects -2  ص التالية:ي الخصائويشمل التحكم فمن لوح الخصائص بعد تحديد النظير على المسرح

Brightness درجة السطوع

Tint اللون

Alpha الشفافية

 Advanced التي نستطيع منها تحديد درجة كل لون من الألوان الأساسية و

((RGB  كما يظهر في الشكل التالي

إلغاء رمز
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المكتبة , أو  ونة سلة المهملات فى أسفلمن لوحة المفاتيح , أو انقر على أيق Delete الرمز ثم اضغط فى المكتبة حدد

 . اسحبه إليها

 . من لوحة المفاتيح Delete حدد النظير ثم اضغط وفى المسرح

 :ملحوظة

النظير , ومن أجل تبسيط الشرح وحمايتك من دوامة المصطلحات , من المثيل او الرمز ومفهوم  لقد أوضحت لك مفهوم

الشهيرة : إن أحمد هو نفسه الحاج  لأننا سنعتبر أن النظير هو الرمز ) تطبيقا للقاعدةفصاعدا لن أذكر كلمة نظير  الآن

.( !! أحمد

على  D ووضعه فى القرص C مثلا فى القرص Text ملف أى ملف وليكن إن الأمر ببساطة يشبه عمل نسخه من

لن يتعامل معه باحتقار بسبب ذلك !!  أنهالحاسوب , فالبرغم من أن الكمبيوتر يدرك أن الملف الأخير هو مجرد نسخة إلا 

الأصلى , حتى أنك بعد عدة أيام ربما ستنسى أنه هذا الملف كان  وإنما سيكون لذلك الملف كل صلاحيات ووظائف الملف

كل مرة  وهذا هو ماأريده منك الآن : أن تنسى كلمة نظير وأن تتذكر فقط كلمة رمز ولن أحتاج فى , نسخة عن ملف آخر

 .فأنت أصبحت تدرك ذلك بوضوح رك أن الموجود على المسرح هو النظير والموجود فى المكتبة هو الرمزأن أذك

 Edit Symbolتحرير رمز

 خة وتحرير مقال وتحرير صورة .. إلبالمعنى الفنى مثل تحرير صحيف هنابالطبع كلمة تحرير 

 : وهناك طريقتان لعمل ذلك

 :الطريقة الأولى

أشكال أخرى أو تغيير اللون  وجة على الرمز فى المكتبة , وابدأ فى عمل تعديلاتك مثل وضع شكل أو إضافةنقرة مزد انقر

هنا لن تجد سوى مساحة خاصة بالرمز وستختفى باقى العناصر  أو الحجم .. إلخ . ولكن هذه ليست الطريقة الأمثل , لأنك

 . المسرح التى كانت موجودة على

 :لأفضلالطريقة الثانية وهى ا

العناصر الأخرى بحيث  نقرة مزدوجة على نظير الرمز فى المسرح , وميزة هذه الطريقة أنك تستطيع رؤية باقى انقر

 Edit in فأنت تقوم الآن بعمل Animateالمجاورة . وبلغة  تأخذ فى اعتبارك عند تحرير النظير مدى علاقته بالعناصر

place . 

تمرين:

عينا بأدوات الرسم.صمم رمزا بشكل فراشة مست .1

 Scenesالمشاهد
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 لكل جزء من الفيلم. لتنظيم مستند مواضيعي، يمكنك استخدام المشاهد. على سبيل المثال، يمكنك استخدام مشاهد منفصلة

 عند استخدام مشاهد، يمكنك تجنب الحاجة إلى إدارة عدد كبير من ملفات فلا لأن كل مشهد موجود ضمن ملف فلا واحد.ف

معا لإنشاء عرض تقديمي أكبر. كل مشهد له جدول زمني. يتم  Animateستخدام المشاهد استخدام عدة ملفات يشبه ا

ترقيم الإطارات في المستند على التوالي من خلال الكواليس. على سبيل المثال، إذا كان المستند يحتوي على مشهدين مع 

. يتم عرض المشاهد الموجودة في 20-11 ( بالارقام2) رقم عشرة إطارات لكل منهما، يتم ترقيم الإطارات في المشهد

 رأس التشغيل. عندما يصل رأس التشغيل إلى الإطار النهائي للمشهد، يتحرك المشاهدالمستند بترتيب يتم سردها في لوحة 

 إلى المشهد التالي.

 الصعب ومن جداً  كبير عددها يصبح تاليوبال تعقيداً  تستخدمها التي الأطر عدد تزداد به تقوم الذي العمل حجم يكبر عندما

 ذلك على وكمثال الواحد الفيلم في مشهد من أكثر تستخدم أن لك الأفضل من لذلك ؛ بسهولة تريد الذي الإطار إلى الانتقال

 . بعضا بعضها مع متسلسلة متفرقة مشاهد شكل على وإنما واحد وقت وفي واحدة دفعة يصور لا حيث السينمائي الفيلم

:Scenesد هاالمش حلو

فيظهر اللوح المجاور و المكون من الأجزاء التالية: sceneثم other panels  ثم  windowلاظهار هذا اللوح نختار 

.الفيلم مشاهد بأسماء قائمة .1

 .جديد مشهد إدراجزر  .2

 .مشهد نسخزر  .3

 . مشهد حذفزر  .4

:المشاهد بين التنقل

 .آخر إلى شهدم من للانتقال مشهد تحرير أيقونة انقر .1

.المحدد المشهد أمام  علامة ظهور تلاحظ .2
:المشاهد لتغيير ترتيب

فيلم تغيير ترتيب مشهد في لبعرض المشاهد حسب ترتيب ظهورها في لوحة المشاهد هذه،  Animateعادة يوم 

Animate  مثلا جعلscene2   بلscene1  المشاهد. لوحة فيالبداية  إلى المشهد اسم اسحب 

Animationكة الحر

يعنى  Animation هو برنامج جرافيكس قائم على الحركة , إن مصطلح Animateبرنامج  كما أوضحنا من قبل أن

بدايتها فى الثلث الثانى من القرن  الحياة أو الحركة فى شيئ ما , وقد تم إطلاق هذا الإسم على الرسوم المتحركة عند بعث

 . الماضى

 الى خمسة أنواع رئيسة هي: Animateويمكننا تقسيم الحركة فى 

 Frame by frame الحركة اطار اطار .1

Shape Tweenحركة  .2

Classic Tweenحركة  .3

Motion Tweenحركة  .4

Boneحركة العظمة  .5
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  Frame by Frameإطار الحركة إطار. 1

لقطة فى صفحة مستقلة على  المتحركة فى الماضى , كان الرسام يرسم كل هل تتصورون كيف كان يتم عمل أفلام الرسوم

الثانية  يتم وضع الصفحة الأولى فوق لوح زجاجى يوجد بأسفله مصدر إضاءة ثم يتم وضع الصفحة ورق شفاف , وكان

يتم إعادة رسم ماهو موجود فى الصفحة  فوق الأولى وهكذا يستطيع الرسام رؤية تفاصيل الرسم فى الصفحة الأولى , ثم

يتم رسم فيلم الرسوم المتحركة صفحة صفحة )أى لقطة لقطة ( , ثم يتم  لات الطفيفة, وهكذاالأولى مع عمل بعض التعدي

 . تتحرك لقطة مستقلة , وعند مشاهدة تلك اللقطات بتتابع سرعة الفيلم نشاهد العناصر وكأنها تصوير كل صفحة فى

ل لقطة مع عمل التغيير المطلوب , ك إننا نقوم برسم العنصر فى , Frame - by - Frame Animation وهذه هى فكرة

أن تكون هذه الحركة مثلا رفرفة جناحين لفراشة أو سير الأقدام ..  وهكذا نحصل على الحركة عند مشاهدة الفيلم . ويمكن

 إلخ

 :ن لعمل ذلكهناك طريقتا

إطار مفتاحى  Blank Keyframes الأولى باستعمال الطريقة 

 طار مفتاحىإ  Keyframe  والطريقة الثانية باستعمال 

  Balnk Keyframe ة الاطار المفتاحي الفارغ طريق .1

 الأيمن للماوس واختر ثم انقر بالزر 10الإطارات العشرة الأولى وذلك بالسحب بالماوس نحو الإطار رقم  قم بتحديد. 1

Convert to Blank Keyframes 

 Pencil رسم خط مستقيم صغير بأداة القلم الرصاصقم ب. 2

انتقلنا إلى إطار مفتاح  بالنقر عليه , ماذا تلاحظ ؟ لقد اختفى الخط ) وأعتقد أنك تعلم سبب ذلك , لقد انتقل للإطار التالى. 3

 حاليا(  keyframeتختفي العنصر الظاهرة في  blankkey frameالى   keyframe)يعني دايما ما نطلع من  فارغ( ,

المتحركة فى الماضى , وسنضع صفحات الرسم الشفافة فوق  فعل مصمموا الرسوموالآن نريد أن نفعل مثلما كان ي 

. Animateالصفحات معا , وسنفعل ذلك بطريقة  بعضها البعض بحيث نرى كل

. الصورة كما فىOnion Skin انقر بالماوس على زر
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 يعرض

مرة ,  Flash ل فى ك فى الحالة الطبيعية محتويات منصة العمل المقابلة لإطار واحد

فى   فيمكنك أن ترى محتويات عدة إطارات Onion Skin لكن إذا قمت بتفعيل سمة

يعنى قشرة البصلة ومعناها أننا نستطيع  Onion Skin الوقت نفسه , إن خيار أن نرى

. من خلال الأشكال المتراكمة , وكان لديك بصلة ترى مابداخلها قشرة قشرة

كما  خافت ,  ماذا تلاحظ الآن ؟ لقد ظهر الخط على المسرح مرة أخرى ولكن بلون

 . التى ستظهر بمظهر قشرة السمكة ظهر شيئا آخر فى منطقة الإطارات , علامتان مثل القوسان يحددان الإطارات

كما فى 10التى تريدها , اسحب القوس الأينم إلى الإطار الأخير رقم  الأقواس لتغطى الإطارات وبالطبع يمكنك سحب هذه

  الصورة

إضافة خطا آخر عموديا عليه ) اضعط على  مع , قم برسم خط فوق الخط الأول تماما 2الآن أنت فى الإطار رقم  - 4

.. وارسم الشكل السابق ثم أضف خطا عموديا آخر , وهكذا 3للإطار رقم  أثناء الرسم ( , ثم انتقل Shift مفتاح

 : ستحصل على شكل حلزونى كما فى الصورة التالية وفى النهاية

. لنقم باختبار العمل والآن

العمل اختبار

 Enter لإختبار العمل فى داخل البرنامج انقر على- أولا
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الإطارات وتشاهد حركة الكائن أو الكائنات داخل المسرح على Playhead حيث تشاهد حركة

 من القائمة Controller يمكنك استخدام ولمزيد من التحكم فى العرض

Window > Toolbars > Controller 

 للتشغيل .1

 رتقدم للأمام بمقدار إطا .2

 لنهاية المشهد الذهاب .3

ررجوع للخلف بمقدار إطا .4

 الذهاب لبداية المشهد .5

 إيقاف .6

 اذهب للقائمة  Flash Playerلإختبار العمل بمشغل فلاش - ثانيا

Control > Test Movie 

Ctrl+ Enter أو ببساطة اضغط

 : بشكل أكثر سهولة وحرفية ولكن والآن أدعوكم لتعلم المزيد من المهارات , وسنقوم بعمل الخطوات السابقة

  1ارسم خطا كما فى الخطوة . 1

لإستحضار أداة  Ctrl الحالية معك الآن هى القلم الرصاص , لاتتركها , فقط استمر فى الضغط على مفتاح الأداة. 2

 . لنسخ الشكل Ctrl+C التحديد بشكل مؤقت وقم بتحديد الخط بعمل إطار حوله , ثم اضغط

  ثم من القائمة 2 انقر على الإطار. 3

Edit > Paste in place 

  أو اضغط مفاتيح الإختصار

Ctrl+Shift+V 

كله  , والآن أضف خطا عموديا , ثم استحضر أداة التحديد وقم بعمل إطار حول الشكل 2الإطار  سيتم لصق الشكل فى

 .. وكرر ماسبق , وهكذا 3لنسخ الشكل ثم انتقل للإطار  Ctrl+C لتحديده , ثم

  Keyframe ة الاطار المفتاحي طريق .2
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 . فى الطريقة السابقة 1قم برسم خط كما فى خطوة  .1

 الأول ثم قم برسم خط آخر عمودى على الخط Keyframe لإنشاء F6 على الإطار التالى ثم اضغط انقر .2

.. وارسم خطا آخر بشكل عمودى F6 ثم انتقل للإطار التالى واضغط

 . ل على الشكل الحلزونىوهكذا حتى تحص

 . كما فى الطريقة الأولى وفى النهاية ستحصل على نفس الحركة

الطريقتين , لأننى فى الحقيقة وجدتها فرصة سانحة كى  وستلاحظ أن الطريقة الثانية أسهل بكثير , ولكنى تعمدت ذكر

 : نتعلم الأشياء التالية

Blank Keyframe و Keyframe زيد من التركيز على معرفة الفرق بينم .1

Onion Skin معرفة وظيفة .2

  Paste in Place استخدام .3

تمارين:

مستخدما أسلوب الحركة اطار اطار صمم مشهدا تظهر فيه دائرة يتغير لونها كل نصف ثانية بين الألوان  .1

 بنفسجي(-اصفر-اخضر-احمر-التالية)ازرق

بعد ظهوره بطريقة عكسية اعد المشهد السابق الخاص بالخط الحلزوني لجعل الخط يختفي .2

صمم مشهدا تظهر فيه شجرة تنمو باستخدام الحركة اطار اطار .3

 Shape Tween ل(لشكباالتحول البينى حركة ).2

الإطار الأخير ثم جعل البرنامج يقوم بصنع  الذى يعتمد على قيامك بصنع الإطار الأول وصنعهو   يالتحول البين

 . بينى " أى بين الإطارات " مصطلحالإطارات بينهما , ومن هنا جاء 

 Shape Tween شكل آخر, حيث نضع كائنا فى الإطار الأول ثم  تحول شكل إلى هو طةاببس   أو التحول البينى للشكل

 ويقوم البرنامج بعمل تغير تدريجى فى شكل الكائن الأول حتى يتحول فى النهاية إلى ,نضع كائنا ثانيا فى الإطار الأخير

 . لثانىالكائن ا

وهو ، Morphingعلي يطلق ما أو للعناصر التحولات تأثيرات عمل يمكننا Shape Tween التحريك أسلوب باستخدام

ً  أخر شكل إلى معين شكل تحول عن عبارة  .إطارات عدة خلال تدريجيا

 :ويمكن عمل ذلك بطريقتين

:تحويل دائرة الى مستطيل الأشكال( العادية )تحولالطريقة  : أولا
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. قم برسم دائرة فى الإطار الأول .1

لإنشاء إطار مفتاحى فارغ  F7 لتحديده ثم اضغط 35انقر على الإطار  .2

. الدائرة من المسرح, ثم قم برسم مستطيل أى لإزالة

 create shape tweenعلى الزر الأيمن للماوس و اختر  ثم ة الإطارات قمنط انقر على  .3

الفاتح , وظهر سهم بين  ير لون الإطارات بين الإطار الأول والأخير إلى اللون الأخضرتلاحظ الآن ؟ , لقد تغ ماذا

  الإطارين

. لاختبار فيلمك . حيث ترى الدائرة تتحول إلى مستطيل تدريجيا Ctrl+Enter اضغط .4

أونقاط تلميح الشكل  Shape Hintباستخدام : ثانيا

إلى الشكل الثانى , وفائدة هذه  ة نقاط إرتكاز يعتمد عليها الشكل الإول خلال تحولهباستخدام نقاط تلميح تكون بمثاب أى

التشوهات الشكلية التى قد تظهر أثناء تشغيل الفيلم . وتبرز أهمية  النقاط هى جعل التحول فى الشكل أكثر نعومة وإزالة

 . التعامل مع الأشكال التى لها أطراف هذه الطريقة عند

 : الوالآن إلى المث

1الخلفية أسود , ثم قم برسم نجمة بيضاء عند الإطار  قم بفتح مستند جديد ومن لوح خصائصه اختر لون. 1

 ثم ارسم دائرة بيضاء , وحولها إلى هلال عن طريق رسم دائرة سوداء فوق جزء منها , F7 اضغط 35عند الإطار . 2

 : كما فى الصورتين التاليتين Delete ثم الضغط على مفتاح
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المثال السابق , ويمكنك الآن اختبار فيلمك  كما فعلنا فى Shape ومن لوح الخصائص اختر نوع 1ذهب للإطار . ا3

 . عمال الطريقة كما سنوضحها الآنالنهائية بعد است حتى يمكنك المقارنه بينه وبين النتيجة

التلميح الأولى , اذهب للقائمة الآن سنضيف نقطة. 4

Modify > Shape > Add Shape Hint 

 د رؤوس النجمةقم بسحبها إلى إلى أح a دائرة صغيرة بها حرف ستظهر

الإطار الأخير ( حيث  لتتعقب مكان ذلك الرأس ومكانه فى الشكل النهائى ) فى Playhead الماوس قم بتحريك. ب5

  الرأس العلوى للهلال ستجد أن رأس النجمة الذى وضعت عنده نقطة التلميح سيتحول إلى

طة التلميح (تنتظر منك وضعها فى مكانها فى الشكل النهائى نق ) على الإطار الأخير , حيث تجد الدائرة الصغيرة . انقر6
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. الهلال , قم بتحريكها نحو رأس

النجمة , ثم تعقب مكانها النهائى عند الإطار  عد للإطار الأول وقم بوضع نقطة تلميح أخرى أخرى فى أحد رؤوس. 7

  والهلالوهكذا حتى تملأ كل رؤوس النجمة  .. الأخير وضع النقطة فى ذلك الموضع

حتى نحصل على النعومة الكاملة ستحتاج إلى نقاط  الآن اختبر فيلمك ولاحظ أن التحول الشكلى صار أنعم . بالطبع. 8

 ولكن لم أرد الإطالة أكثر من ذلك وأعتقد أن الفكرة واضحة وهذا هو مايهمنا فى , إضافية عند الزوايا بين الرؤوس

 . المرحلة الحالية

:البيني بالشكل على النصوص  تطبيق التحول

أولا  ولاستعماله مع النصوص يجب تحويل النص , Shape لأى شكل , Shape Tween يمكنك استعمال فى الحقيقة

 : عن طريق الخطوات التالية Shapeإلى شكل

وانقر على النص لتحديده Selection Tool التحديد اكتب النص , ثم اختر أداة. 1

 ةاذهب للقائم. 2

Modify > Break Apart
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  وقم بتكرار ذلك مرة ثانية

. مرتين Ctrl+B أو من لوحة المفاتيح اضغط

  النص هكذا فى المرة الأولى سيكون

المرة الثانية سيظهر النص هكذا وفى

. أنه تحول فى المرة الثانية إلى شكل أى

نتعامل مع نص مكون من عدة حروف , ولكن حين يكون النص مرتين لأننا  Break Apart فى الحقيقة لقد قمنا بعمل

   فسنقوم بعمل ذلك مرة واحدة هو حرف واحد

 :تطبيق التحول البيني بالشكل على الصور 

 أم صورا أكانت سواء خارجية ملفات لاستيرادو Animateمن اجل التعامل مع الصور نقوم أولا باستيرادها الى فيلم 

 :جهازك على موجودة أفلاما

و يعني استيراد Importثم الامر  Fileاختر قائمة  .1

اختر احد الخيارين التاليين: .2

: الخيارين أحد اختر ثم        

 Import to Library  الفيلم لمكتبة الملفات لاستيراد. 

   Import to Stage العمل مسرح إلى الملفات لاستيراد.

  Shapeحتى يمكننا تطبيق إلى شكل اولا هايجب تحويلالنسبة للنصوص , هو الحال ب كمابعد إضافة الصور فإنها  

Tween عليها , ولكن الطريقة ستختلف عن الطريقة بالنسبة للنص , وذلك كالتالى : 

    Modify > Bitmap > Trace Bitmap  : بتحديد الصورة وهى على المسرح , ثم اذهب للقائمة قم
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كما يظهر: 2الى صورة  1يقوم بتحويل صورة صمم مشهدا   مثال :

التحكم فى سرعة التحول البينى للشكل

ولكن ماذا لو أردنا تغيير  , الوضع الإفتراضى تتم عملية التحول البينى بنفش السرعة من الإطار الأول وحتى الأخير فى

فى لوح  Ease كس ؟ فى هذه الحالة سنلجأ إلى خاصيةالنهاية أو الع ذلك وجعل الحركة سريعة فى البداية ثم تتباطأ نحو

ويجب الأخذ فى الاعتبار أن القيم العددية الموجبة تعنى  , حيث يمكن كتابة القيمة العددية مباشرة  Properties الخواص

 . سريعة فى البداية ثم تتباطئ نحو النهاية , والقيم السالبة تعنى العكس ان سرعة التحول ستكون

 Blendأسلوب التحول البينى عن طريق م فىالتحك

 : حيث يوجد خياران Blend لخاصية القائمةانقر على 

- Distributive  ويجعل الشكل أثناء التحول ناعما فى الأطراف والزوايا بقدر الإمكان , وهو الإفتراضى .

- Angular  الكائن  بوضوح عندما يكون يظهر ذلك التأثيريحافظ على حدة الزوايا والخطوط المستقيمة أثناء التحول , و

. الأول والثانى يملكان زوايا حادة وخطوط مستقيمة

واحدة تعديل عدة إطارات مرة

 ( (Shape Tween عدة إطارات فى الوقت نفسه , فلو كان لدينا فى المثال السابق المقصود بهذه العملية هو إعادة تحرير

يتواجدا فى مركز المسرح  نا مثلا تغيير مكان وجود العنصرين على المسرح فبدلا من أنتتحول إلى مستطيل , وأرد دائرة

أن نذهب إلى كل إطار ثم نقوم بنقل العنصر , ولكن هذه  نريد جعلهما فى الطرف الأيسر مثلا , وفى هذه الحالة علينا

المكان  ضا لن نستطيع أن نضع العنصر فىفبالإضافة إلى أنها تحتاج إلى خطوات طويلة , أي الطريقة بالطبع غير عملية
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وآخر . أما الطريقة الأكثر  نفسه بدقة فى كل إطار ولذا سنحصل على عناصر تتحرك حركات متذبذبة بين كل إطار

 . Edit Multiple Frames سهولة والأكثر دقة فتكمن فى استعمال

 : وإليك الطريقة

الصورة . لاحظ القوسين الذين سيظهران فى شريط أرقام  فىكما  Edit Multiple Frames انقر على أيقونة. 1

 . الإطارات

. القوس الأيمن إلى الإطار الأخير قم بسحب. 2

.ناصرلتحديد كل الع Ctrl+A جزء فى المسرح ثم اضغط أنقر على أى. 3

وضوح بسحب العنصر ولاحظ أنك تسحب العنصرين معا كما يظهر فى الصورة التالية بكل قم الآن . 4

. لاختبار العمل Ctrl+Enter مهمتها. والآن انقر فقد انتهت Edit Multiple Frames انقر مرة أخرى على أيقونة. 5

 تمارين

ط مستقيم و من ثم يتحول الخط الى مثلث و أخيرا المثلث الى صمم مشهدا تظهر فيه نجمة خماسية تتحول الى خ .1

 نجمة مرة اخرى

  صمم مشهدا تظهر فيه عشرة من أسماء الله الحسنى بشكل متتابع .2
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 صمم مشهدا تظهر فيه صورتك في مراحل عمرك المختلفة. .3

الى صفر باستخدام التحول البيني بالشكل 5صمم مشهدا للعدد التنازلي من  .4

حول البيني بالشكل باستخدام التدرج اللوني :تطبيق الت

كرة للإيحاء بأن  بإسلوب آخر مستخدمين التدرج اللونى لإحداث نوع من الحركة الشكلية على Shape Tween سنطبق 

 . هنالك بقعة ضوئية تتحرك فوقها

:ظاهرا لديك قم بإظهاره من القائمة  Color Mixer إذا لم يكن لوح. 1

أو  shift+F9 Window > Color Mixer المفاتيح اضغط من لوحة

قلم رصاص , حيث  وهو المربع الذى ترى بجواره  Stroke Color انقر على مربع

إلغاء اللون  اللوحة من جهة اليمين انقر على مربع تظهر لك لوحة الألوان وفى أعلى 

) الذى به خط مثل المربع فى  (الصورة

  . لتحديده Fill Color لون الملء ثم انقر على

. Type من خانة Radial قم بتغيير ذلك إلى تدرج من نوع , Solid فى الوضع الإعتيادى يكون لون الملء لونا واحدا

الأبيض والأسود , ولكن فقط سنقوم بعكس  بتغيير اللونين الإعتياديين وهما لن نقوم

شريط التدرج , ففى الوضع الإعتيادى يكون الأبيض على اليمين والأسود  مكانهما فى

يبدأ التدرج من الأسود فى المركز إلى الأبيض فى الخارج كما فى  على اليسار بحيث

 الصورة

ليبدو كما فى الصورة  الآن بعكس ذلك بتحريك مؤشر الأبيض يسارا والأسود يمينا سنقوم

 . التالية
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 . الأسود فى طرفه الخارجى ومعنى ذلك أنه سيكون التدرج الآن من الأبيض فى مركز الشكل إلى

 . للحصول على دائرة منتظمة Shift مفتاح مع الضغط على Oval Tool قم برسم دائرة باستخدام. 2

لإنشاء  F7 استخدمنا Shape Tween لإدراج إطار مفتاحى ) فى الدرس السابق F6 ثم اضغط 20الإطار رقم  انقر على

بتحول العنصر الأول إلى العنصر الثانى , ولكننا هنا  إطار مفتاحى فارغ ورسمنا عنصر ثانيا وكان التغير فى الشكل يتم

. ( نفس العنصر بتغيير مكان الإضاءة عليه إحداث التغير الشكلى فى نريد

. إليه الآن انقر على الإطار الأول للعودة

من صندوق الأدوات Gradient transform Tool انقر على أداة. 3

  . انقر على الدائرة ثم ,

التدرج إلى الأعلى يسارا , ثم توسيع حجم  تستطيع تحريك مركز ولو كنت قد تابعت الدروس من البداية , فلا شك أنك. 4

. التاليتين التدرج كما فى الصورتين

 ستبدو الكرة هكذا الآن. 5
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وقم بتحريك مركز  , مرة أخرى Gradient transform Tool بالنقر على الإطار الأخير ثم انقر على الأداة قم. 6

 . بهذا الشكلالتدرج إلى الأسفل يمينا , لتبدو الكرة 

ثم قم باختبار العمل Create Shape Tween اختر نوعواذهب للإطار الأول  .7

 Tween  Classicحركةالتحول الكلاسيكي بال .3

 Classic Tween   ها في الإصدارات السابقة من التي تم إنشاؤ ركاتالحالتي تتضمن جميع وهيFlash فهي أكثر ،

الكلاسيكية توفر بعض القدرات المحددة التي يحتاجها بعض المستخدمين.هذا النوع من الحركات  ولكنتعقيدا لإنشاءها. 

 ونغير الأخير الإطار إلى نأتي ثم الأول الإطار في كائنا نضع فنحن ، الكائن مكان تغير على Classic Tween يعتمد

 مشاهدة وعند الأخير مكانه إلى الأول مكانه من الكائن موضع في تدريجي تغيير بعمل Animate يقوم ثم ، الكائن مكان

 ر.لآخ مكان من يتحرك الكائن وكأن لنا يبدو اللقطات بتتابع الفيلم

ي. في الرسوم المتحركة ،يمكنك تعريف يتم تعريف التغييرات في الرسوم المتحركة الكلاسيكية في الإطار الرئيس

ينشئ محتويات الإطارات البينية. وكما مر معنا، فإنه يتم الإشارة إلى  Animateالإطارات الرئيسية كنقاط هامة فيها و

الإطارات الأساسية في المخطط الزمني بالدائرة الصلبة السوداء و تكون الإطارات الأساسية فقط قابلة للتعديل في الحركة 

و لتعديل الإطارات البينية قم بتغيير الكلاسيكية. اما الإطارات البينية فيمكنك عرضها ولكن لا يمكنك تحريرها مباشرة. 

  أحد الإطارات الرئيسية المحددة أو أدخل إطارا أساسيا جديدا بين الإطارين الرئيسيين للبدء والنهاية.

 : العملي التطبيق إلى والآن 

. العمل مسرح يسار أعلى في ا الخارجي اسود وتعبئتها بلون اخضر فاتحلون حده دائرة ارسم .1
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فنلاحظ ان  Create Classic Tween  الأمر اختر ثم ، بالدائرة الخاص المفتاحي الإطار على الأيمن بالزر أنقر .2

Animate قام بتحويل الدائرة الى رمز 

Key Frame مفتاحي إطار لعمل F6 اضغط ثم ، مثلا 24 الإطار على انقر .3

. .العمل مسرح يمين إلى بسحبها الدائرة مكان بتغيير قم ثم ، 24 الإطار حدد .4

زرقاء خلفية له سهم شكل على الزمن شريط يصبح

لمعاينة المفاتيح لوح من Enter مفتاح اضغط

 .الحركة

اية ونقطة النهاية فقط للحركة عند هنا نلاحظ اننا انشأنا نقطة البدفنشاهد ان الكرة تتحرك من يسار المسرح الى يمينه. 

  بأنشائها. Animateاما الإطارات البينية فيقوم  للنهاية. 24للبداية و 1الإطارات رقم 

صمم مشهدا يتحرك فيه مربع على زوايا المسرح الأربعة كما في الصورة مثال:

السابقة رسمت المستطيلات كلها على  ملاحظة: في الرسمة 

 (مشروح تاليا)التحكم بالسرعة ضيح فقط اما عند التنفيذ فيظهر مستطيل واحد فقط في المرة الواحدة.المسرح للتو

 تغييرات أخرى يمكن تطبيقها

يقتصر فقط على تحريك الكائن , وكما شرحنا من قبل أن الحركة ما هى  لا Motion Tween إن التحول البينى للحركة

لآخر , لذلك يمكننا تطبيق مبدا التغير فى  الكائن من إطار إلا تغير فى مكان

  Tweeningفي الجزء  Propertiesخصائص أخرى للكائن من خلال لوح 

  : الظاهر في الشكل و تشمل مثل

 خيارات انقر على الإطار الأول ثم اختر ماتريد من  Rotate الدوران  .1

Rotate الأربع :

- None عدم الدوران . 

- Auto فسيتم  , تدوير العنصر فى الإطار الأخيرإذا كنت قد قمت ب

 . الدوران فى نفس الإتجاه

- CW عقارب الساعة الدوران فى اتجاه .
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- CCW الدوران عكس عقارب الساعة .

سيدور  2مثلا لو ادخلنا  rotateمة قائكما يمكننا تحديد عدد مرات الدوران بإدخال العدد المطلوب كتابة بجانب 

انتقاله من الاطار الأول للاخيرالكائن مرتين اثناء 

الحركة التحكم فى سرعة.  2

 Easeم أولا باستخدا

وحتى نهايته , ولكن ماذا لو أردنا تغيير ذلك وجعل  لاحظنا فى الفيلم أن حركة الدائرة تسير بنفس السرعة من بداية الفيلم

 نا سنحتاج إلى التعديل فى أحد خواص الحركة وهىتتباطئ نحو النهاية أو العكس , ه السرعة مثلا سريعة فى البداية ثم

Ease  القيمة الإفتراضية تكون صفر , وهذا يعنى أن  لاحظ أن،فى لوح الخصائص , ويكون ذلك بتغيير القيمة العددية

 . النهاية السرعة تكون بنفس المعدل من البداية إلى

تظهر مع القيم السالبة . الآن انقر على الإطار  In لمةوك تظهر مع القيم الموجبة Out وكتوضيح من البرنامج فإن كلمة

 . نحو النهاية , وقم باختبار الفيلم , لتجد أن الدائرة تتحرك بسرعة أولا ثم ببطء 100القيمة إلى  الأول , وقم مثلا بتغيير

 م تتسارع نحو النهايةالدائرة تسير ببطء أولا ث قم بتغيير القيمة مرة أخرى واجعلها سالبة واختبر الفيلم لتجد أن

 Editباستخدام  ثانيا

هذه الخاصية تسمح بالتحكم بشكل أدق فى نمط الحركة , انقر 

 لك اللوحة التالية حيث تظهر Ease على رمز القلم المجاور لـ

في البداية، و قبل تغيير أي قيم لتغيير سرعة الحركة يكون 

ة. لما عند تغيير المنحنى بهذا الشكل مما يعني ان السرعة ثابت

 يصبح بأحد الشكلين:  Easeالسرعة باستخدام 

ثم تتراجع للوراء ثم  جعل الدائرة تسيرالمنحنى التالي يمثلا ، تغيير شكل المنحنى لإحداث نمط الحركة كما تريد تستطيع

 .تتقدم وتكمل سيرها نحو النهاية
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 وإذا أردت , Alt ابق وضعها , انقر عليها مع الضغط على مفتاحفى المنحنى وإعادتها لس إحدى النقاط إذا أردت إلغاء

 . Reset إلغاء جميع النقط وإعادة المنحنى لوضعه الإفتراضى انقر على

  . اللوحة تجد أرقام الإطارات حتى تحدد بكل دقة وقت التغيير المطلوب وفى أسفل

اليسار , عندئذ  اح التشغيل فى اسفل اللوحة إلىمشاهدة التغييرات واختبارها عن طريق الضغط على مفت كما يمكنك

إزاحتها إلى اليمين قليلا لرؤية مسرح العمل ,  ستشاهد الحركة فى مسرح العمل , ولأن حجم اللوحة كبير نسبيا فعليك

 ملالحالى وتريد إضافة المزيد من التعديلات , اضغط زر الإيقاف المجاور وقم بع وإذا لم تكن راضيا عن معدل السرعة

 . التعديلات المطلوبة ثم اختبر التغييرات مرة أخرى

الحركة حسب مسار

جعل الحركة تسير فى  كيفية عمل حركة , ولكننا نلاحظ أن الحركة تسير فى خط مستقيم . ولكن ماذا لو أردنا قد تعلمنا

نريده ثم نجعل العنصر يتحرك على المسار بالشكل الذى  مسار متعرج أو مسار دائرى .. إلخ , فى هذه الحالة سنقوم برسم

 : الشرح هذا المسار . والآن هيا إلى

)حتى ان نسيت تحويلها فإن البرنامج يحوله(. Graphic    قم برسم دائرة ثم حددها بالكامل وحولها إلى رمز من نوع.1 

 . لعمل إطار مفتاحى F6 واضغط 30انقر على الإطار . 2

 Add Classic Motion Guide فو اسم الطبة التي تحتوي الدائرة واختر الامر الزر الأيمن للماوسانقر على . 3

 الحالية. ةة و تظهر فو الطبقلإضافة طبقة اسمها الطبقة الدليلي

 . ستتحرك الدائرة عليه الدليلية ستنشأ فوق الطبقة الحالية , وستكون مهمة الطبقة هو تحديد المسار الذى الطبقة
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خطا به العديد من  لى الإطار الأول فى الطبقة الدليلية ثم اختر أداة القلم الرصاص من الأدوات , وارسمع نقر. ا4

 . المنحنيات

. الطبقة الدليلية بالنقر على النقطة الصغيرة أسفل أيقونة القفل قم بقفل. 5

والأخير ولا نريد تحريك خط  ئرة فى الإطار الأولذلك هو أننا الآن سننتقل إلى الطبقة الأولى ونغير مكان الدا والهدف من

 . عن طريق الخطأ -الذى رسمناه  -المسار 

مركزها فى بداية خط  الإطار الأول فى الطبقة الأولى وقم بتحريك الدائرة باستخدام أداة التحديد ليستقر انقر على .6

  .المسار

الإطار الأخير فى الطبقة الأولى وحرك  على  انقر .8

لدائرة ليستقر ا . المسار مركزها على نهاية خط

 Create classic motionأي اطاربين الأول و الأخير في طبقة الدائرة بالزر الأيمن و اختر انقر على . 8

 . الذى رسمناه لا يظهر بالطبع فى الفيلم النهائى لاختبار الفيلم. لاحظ أن المسار Ctrl+Enter الآن اضغط

أثناء حركته على المسار الكائنالتحكم فى اتجاه 

عن سهم ونريد أن نجعل السهم يسير على المسار الذى حددناه بحيث يتغير إتجاهه  لنفرض أن الكائن هو عبارة

 Orient to الخيار لإنحناءات المسار وبحيث يكون اتجاه رأس السهم فى نفس اتجاه الحركة , هنا سنحدد وفقا

path فى لوح الخواص Properties .

 لتفعيل أداة Q الأول ثم قم بوضع السهم على مقدمة المسار مع تعديل إتجاهه , ولتنفيذ ذلك اضغط حدد الإطار

Free Transform ر , حدد نفس اتجاه بداية المسا أو اخترها من الأدوات وقم بتدوير السهم بحيث يكون فى

 ئ نفسهالإطار الأخير وافعل الش

. بار العمللإخت Ctrl+Enter اضغط
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تمارين على الحركة الكلاسيكية:

صمم مشهدا تدور فيع نحلة في مسار دائري كما يظهر في الشكل المجاور .1

صمم مشهدا لسيارة تتحرك في مسار محدد  .2

صمم مشهدا لكرة السلة اثناء دخولها في السلة  .3

 Tween  Motionالتحول بالحركة .4

نقوم يدويا بإضافة الإطارات الرئيسية كما في النوع السابق، وانما في هذا النوع لا 

 اثناء انشاء الحركة. يتم اضافتها تلقائيا

و لتوضيح الحركة، سنقوم بتطبيق المثال السابق الذي يحرك مستطيلا على الزوايا 

 خطوة خطوة.

 زاوية العليا اليسرى في الاطار الأول فيفي ال 1المرقم ب  ارسم المستطيل .1

خط الزمن

.graphicحدد المستطيل كاملا وحوله الى رمز من نوع  .2

قف على الاطار الأول و اضغط على الزر الأيمن للماوس واختر  .3

create motion tween فنلاحظ ان .Animate  24يحدد 

 بلون ازرق فاتحاطارا كما في الشكل 

 اذا اردنا طول المشهد اربع ثواني الان نسحب على الإطارات بالماوس بحسب طول المشهد المطلوب، مثلا .4

كما في الشكل التالي. 96نسحب لغاية الاطار 
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)نهاية الثانية  24نسحب رأس التشغيل الأحمر للاطار  .5

كما  2الأولى( ثم ننقل بالماوس المستطيل الى الموقع رقم 

 :في الشكل فنلاحظ ظهور

خط اخضر منقط يصل بين الموقعين .1

 24نقطة ماسية عند الاطار  .2

)نهاية الثانية  48نسحب رأس التشغيل الأحمر للاطار  .6

 3الثانية( ثم ننقل بالماوس المستطيل الى الموقع رقم 

)نهاية الثانية  72نسحب رأس التشغيل الأحمر للاطار  .7

 4الثالثة( ثم ننقل بالماوس المستطيل الى الموقع رقم 

)نهاية الثانية  96نسحب رأس التشغيل الأحمر للاطار  .8

1بعة( ثم ننقل بالماوس المستطيل الى الموقع رقم الرا

فنحصل على الشكل التالي:

شغل  .9

الفيلم وشاهد الحركة.

ما يمكن تطبيقه على الحركة بعد انشائها:

نستطيع تعديل المسار الذي يسير فيه المستطيل بكل سهولة من خلال سحب الخط الأخضر المنقط من النقاط،  .1

قليلا  انمنحني والسفلي لعلويفمثلا لجعل الخط ا

كما في  نسحب الخط حسب الاتجاه المطلوب.

 الشكل التالي:

عند محاولة تغيير سرعة المستطيل في المرحلة  .2

نلاحظ  easeالأولى و جعلها سريعة من خلال 

انه يطبق هذه السرعة على كل المسارات، أي 
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الحركة الكلاسيكية.انه لا يوجد فصل بين المراحل الأربعة كما كان الحال في 

و يعطي تحكما اكثر في تحريك   classic tweenاسهل من   motion tween  نستنتج ان انشاء الحركة باستخدام 

   . classic tweenالا انه لا يسمح بتحديد السرعات بدقة في المراحل المختلفة مثل المسار و تغيير اتجاه الحركة، 

Motion Presetsمسبقا استخدام اعدادات الحركة المخزنة 

. يمكنك إنشاء المسرحالحركة المسبقة هي أدوات موالفة للحركة تم تكوينها مسبقاً والتي يمكنك تطبيقها على كائن في 

 يمكنك استخدام الإعدادات المسبقة للحركة التي قمت بتعديلها كما وحفظ الإعدادات المسبقة المخصصة الخاصة بك. 

تتيح لك لوحة كما أثناء تصميم وتطوير مشاريعك، يوفر الكثير من الوقت ات المسبقة أن يوفر استخدام الإعداد

Motion Presets أيضًا استيراد وتصدير الإعدادات المسبقة 

لتطبيق إعداد مسبق للحركة

على كائن غير قابل للتحويل، فإن  Motion Presetحدد كائن قابل للتحويل على المسرح. إذا قمت بتطبيق  .1

Animate .يوفر لك خيارات لتحويل الكائن إلى رمز

 .Motion Presetsحدد إعداداً مسبقاً في لوحة  .2

انقر فوق الزر تطبيق في اللوحة أو اختر تطبيق في الموقع الحالي من قائمة اللوحة .3

 مثال: 

 Bounce in 3Dطبق عليها الاعداد المسبق دائرة وارسم 

 convert toثم  modifyملاحظة: بعد رسم الدائرة انتبه الى انه يجب تحويلها الى رمز من خلال تحديدها كاملة ثم 

symbol   من نوعgraphic
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تخزين اعداد حركة ضمن الاعدادات المسبقة:

ق واردنا تخزينه بحيث اذا قمنا بانشاء حركة لعنصر على سبيل المثال المسار المربع الذي انشأناه لشكل المربع الساب

 يتم تطبيقه مباشرة على أي عنصر اخر بمجرد اختياره نقوم بما يلي:

نحدد الحركة .1

Motion Presetsنضغط على زر  .2

 Save selection as motion presetنضغط على زر  .3

نكتب اسما بالمربع للحركة .4

Bone tool أداة العظمةالرسم ب .5

التي تتكون من مفاصل كحركة الانسان او ، أداة العظمة تستخدم لرسم الكائنات شرح شريط الأدوات عندكما مر معنا 

والتي تتيح لك بسهولة إنشاء  .Inverse Kinematics (IK)من خلال ما يسمى الكينماتيكا العكسية  و غيرها الالات

ستكمل تلقائيا مواقف العظام ي Animateتحديد بداية ونهاية الحركات على الجدول الزمني. و من خلالالحركة الطبيعية. 

يمكنك إضافة عظام إلى مقاطع الفيلم، الرسم، ومفاتيح الزر. او للنص، بعد  في طبقة المحرك بين إطارات البداية والنهاية.

 تحويله إلى رمز أولا. 

ولشرحها  .بعيدا في أشكال منفصلة واستخدام العظام مع الأشكال الفردية  Breakapatملاحظة: يمكنك أيضا كسر النص

سنستخدم عدة امثلة تتدرج في المستوى من السهولة الى المتقدمة.

بطريقتين:  (IK)يمكنك استخدام    

يزحف باستخدام شكل كحاوية لعظام متعددة. على سبيل المثال، يمكنك إضافة العظام إلى رسم ثعبان بحيث  .1

. يمكنك رسم هذه الأشكال في وضع رسم الكائن.بطريقة واقعية
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طريق تسلسل مثيلات الرمز. على سبيل المثال، يمكنك ربط مقاطع الفيلم التي تظهر الجذع والذراع، الذراع  عن .2

السفلى، واليد بحيث تتحرك واقعيا فيما يتعلق بعضها البعض. كل حالة لديها عظم واحد فقط.

باستخدام شكل(:  1مثال )

ح.استخدم أداة المستطيل لإنشاء مستطيل بسيط على المسر .1

الآن استخدم أداة العظمة من الأدوات سترى تغيير المؤشر إلى رمز العظام. الآن انقر على أحدى نهايات  .2

المستطيل واسحب إلى الوسط لإنشاء العظمة.

مثلا ارسم بدءا من  لإنشاء عظام إضافية، انقر على نقطة محورية في العظام واسحب إلى نقطة أخرى في الرسم. .3

محورية عظمة ثانية للجهة الأخرى من المستطيلالنقطة ال

الآن لتحريك العظام، على أي نقطة محورية في الرسم وانقر واسحب المحور لتحريك العظم كله. مثلا انقر على  .4

اخر على اخر نقطة محورية على اليمين في الرسم )على الطرف الأيمن للمستطيل(واسحبه لأسفل للحصول على 

التالي. الشكل 

و لكن  حديد التسليحو ترجمتها  (armatureجديدة بالاسم ) لاحظ الخط الزمني بعد إنشاء بنية العظام. سترى طبقة .5

 يتم استخدام هذه الطبقة لتحريك العظام.حيث . و سنسميها المحرك المقصود هنا البنية العظمية للحركة

 ر ادراج موضع الخاصة بالزر الأيمن اختر الام )او من القائمة F6للتحريك باستخدام طبقة المحرك، اضغط  .6

insert pose ) على أي إطار آخر في المخطط الزمني لإنشاء إطار جديد ونقل العظام إلى مكان جديد. سوف

 تكون الإطارات بين الرسوم المتحركة تلقائيا.

Insert Pose = F6 
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:سلسلة من الرموز (2مثال )

ارسم حلقة وحولها الى رمز .1

واداة التحديد ليصبح  altكرر الحلقة باستخدام  .2

)كن  صل الشكل الأول مع الثاني و تكرار العملية للباقيوم بقو الأولى عند النقطة المحورية اضغط على العظمة  .3

دقيقا بالضغط على مركز العظمة السابقة(

.حرك الحلقة الأخيرة وشاهد كيفية تحريك باقي الحلقات .4

Movie Clipsالعظمة مع الرموز من نوع  عادة تستخدم

قواعد أداة العظمة:

عظمات هي  3مثلا لو قمنا برسم ذراع تتكون من bone system العظام المرتبطة معا تسمى نظام عظمي  .1

العضد و الساعد والكف. تسمى العظمات الثلاثة مجتمعة ب "نظام". 

ترتبط العظام فيما بينها بعلاقة الاب والأبناء. .2
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 كنك إنشاء عظام )أذرع( لأشكال رسومية )مثل مثلث بسيط( أو مجموعة من مقاطع الفيلم.يم .3

تأكد من أن الشكل المراد تحريكه كامل قبل البدء بالتحريك. لن تتمكن من تغيير البنية نفسها في وقت لاحق.  .4

يمكنك فقط تغيير المواضع ، القيام ببعض التحولات وغيرها. 

نشاء العظام ثم استخدام أداة التحديد )السهم الأسود( لتحديدها.استخدام أداة العظام لا .5

نقطة الانطلاق من العظم الأول الذي ترسمه مقفلة / ثابتة للرسمة أو مجموعة من العظام. وبعبارة أخرى، إذا  .6

 تحريك ذراع الإنسان، سوف تبدأ سحب العظام الأولى في الكتف، وليس من اليدين.تريد كنت 

المحرك، يمكنك تمديد الجدول الزمني والنقر بزر الماوس الأيمن / إدراج الموضع، بدلا من الإطار لتحريك طبقة  .7

الرئيسي. في الأساس نفس الشيء ولكن مع أسماء مختلفة.

. سرعة طبقة المحركتشمل: دوران أو عدم دوران، مجموعة دوران والسرعة، وتخفيف الأداة خيارات  .8

حذف العظام:

 دا من ما يلي:إفعل واح      

.delete لحذف عظم فردي وجميع العظام المرتبطة به )أطفاله(، انقر فوق العظم واضغط على المفتاح  •

 مكنك تحديد عظام متعددة لحذف بواسطة شيفت النقر على كل العظام.ي •

من الجدول الزمني، انقر بزر الماوس الأيمن فوق  طبقة المحركأو رمزا لحذف جميع العظام من شكل  •

 .يمنىقائمة الالفي المخطط الزمني واختر إزالة المحرك من الطبقة 

لحذف جميع العظام من شكل على المسرح، انقر نقرا مزدوجا فوق عظم في المحرك لتحديد جميع  •

 العظام. ثم اضغط على حذف.

الأشكال تعود إلى الأشكال العادية.عندها 

وم أولا بتحديد كل الاشكال قن ل و كان هناك عدة عظام مرتبطة معاملاحظة: اذا اردنا استخدام أداة العظمة على اشكا

باحاطتها بمستطيل باستخدام أداة التحديد ليتم التعرف عليها جميعا كنظام واحد ثم نبدأ بانشاء العظام.

تغيير خصائص الحركة:

في لوح  تحديد الإطارات في طبقة المحرك تظهر الخصائص التاليةعند 

 : IKحيث نلاحظ اسمها  الخصائص

يرسم فيها طرق  3حيث هناك  أنماط العظامنختار    styleمن قائمة  .1

Animate :العظام على المرحلة

 .صلب. هذا هو النمط الافتراضي 

  السلكية. مفيدة عندما يحجب النمط الصلب الكثير من الأعمال

 الفنية تحت العظام.

 .خط. مفيدة لدوائر أصغر
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 من خلال  طريقتين: لتحكم بسرعة الحركةل  easeالخيار  .2

a. Strength 100الى + 100-: ادخال قيمة تمثل السرعة بين

b.  من قأئمة typeنختار احد الخيارات الموجودة

على الطبقة بحيث ان السرعة المختارة ستؤثر على الحركة لغاية ال    poseيتم تحديد السرعة عند موضع ملاحظة : 

pose  التالي

مثل بندول الساعة ويعطي تأثير ارتداد الزنبرك springsار الخي .3

لكل الشكل. اما الخيارات السابقة تتحكم بخصائص النظام العظمي ككل 

عندما نريد ان نحدد خصائص مختلفة لكل عظمة او مفصل في النظام 

من لوح الخصائص فإننا نحتاج لعرض خصائص العظام الفردية في 

ككل فيظهر اسمه في لوح  ظام العظميالضغط أولا على النخلال 

لتظهر  ثم على العظمة او المفصل المطلوب التحكم بخصائصهالخصائص 

 :لوحة الخصائص التالية في لوح الخصائص



2024قسم تكنولوجيا المعلومات / خضوري اعداد: أ.أوس رحال

75

سيتم شرح هذه الخصائص على عظمة الساق الخاصة بشكل الرجل المتحرك المجاور:

على او وللتنقل بينها للأحيث ان كل عظمة لها اسم في النظام الواحد. الأسهم الموجودة هنا للتنقل بين العظمات  .1

سفل نضغط على الأسهم.للأ

2. Speed  لو زدنا الرقم تصبح  عظمة او مفصل معين نختاره أولا قم نغير القيمة عند السرعةلتغيير سرعة حركة

ساق كلها تصبح ثقيلة.مثلا لو حددنا عظمة الفخذ وقللنا السرعة نلاحظ ان ال الحركة اخف )اسرع(

3. Enable rotation  : عند وجود  درجة، اما عند  360عند الامر لعظمة محددة فإن هذا يسمح بدوران المفصل

فو ازلنا الإشارة من الامر مع  ازالتها لا يسمح بدورانها نهائيا مع ملاحظة ان هذا لا يؤثر على دوران باقي العظام

دورانها و لكن لا يمنع دوران عظمة الساق. تحديد عظمة الفخذ فإن هذا يمنع

4. X translation زاوية مع إمكانية تقييد  : للسماح /عدم السماح بحركة المفصل و العظمة المرتبطة به افقيا

.constraintsالحركة من خلال 

5. Y translation تقييد زاوية  مع إمكانية : للسماح /عدم السماح بحركة المفصل و العظمة المرتبطة به عموديا

.constraintsالحركة من خلال 
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Layersالطبقات  

أو الكارتون فى  على فهم جيد ومحدد للطبقات , يمكننا تخيل كيف كان الوضع عند تصميم الرسوم المتحركة لكى نتعرف

هذه الأوراق, ويقوم بتوزيع العناصر على  , الماضى , كان الرسام يقوم بوضع عدة أوراق شفافة فوق بعضها البعض

يتحرك وخلفه مجموعة من الأشجار فى الورقة التى تليها , وتختبئ خلف الاشجار  فيمكن أن يكون فى الورقة العلوية أرنبا

 . الأشجار وهكذا فى الورقة التى تليها وهى على وشك الظهور فى اللقطات التالية عندما نزيل ورقة سلحفاة

يكون من الأفضل توزيعها على طبقات بحيث  , الكائنات داخل طبقة واحدةبدلا من وضع كل  Animateوفى برنامج 

كما أن البرنامج يوفر لنا أكثر من نوع من الطبقات ولكل نوع وظيفة مختلفة  , يسهل علينا التعامل معها بالتصميم والتعديل

.من المفيد بالطبع استخدام تلك الأنواع للإستفادة من وظائفها , وسيكون

. لنتعرف على أيقونات لوح الإطارات الواوالآن تع

الملون وظيفة هامة  لكل طبقة مربعا ذو لون مختلف وذلك للتمييز بين الطبقات , كما أن لذلك المربع Animate يجعل. 1

تحديدات بخطوط خارجية فقط دون لون ملء أى  على المربع تصبح الكائنات فى الطبقة عبارة عنأخرى.. فعند النقر 

 . انظروا له فى الحالة العادية , ثم بعد النقر على المربع المذكور , وكمثال لدينا الشكل التالى ,Outlines تصبح

عند وجود كائنات كثيرة موضوعة فى عدة طبقات  ونلاحظ أن التحديد الخارجى صار بنفس لون المربع , ويفيد هذا الأمر

 , تخفيف هذا الزحام بتحويل الكائنات التى لا نعمل عليها حاليا إلى خطوط تحديد م, فى هذه الحالة يمكننا أثناء التصمي

.وسنعرف من خلال لون التحديد الطبقة التى ينتمى لها كل كائن

 .أثناء النقر على المربع Alt على كل الطبقات ماعدا الطبقة الحالية , اضغط ولتطبيق هذا الأمر

على أى شيئ فيها , ويفيد هذا الخيار  ة التى بأسفل القفل لقفل الطبقة بحيث لا يمكن التعديلانقر على هذه النقطة الصغير. 2

. نقوم بتعديلات عن طريق الخطأ على كائنات فى طبقات أخرى عندما نريد العمل على كائن فى طبقة ولا نريد أن

 .اء النقر على النقطةأثن Alt كل الطبقات ماعدا الطبقة الحالية , اضغط ولتطبيق هذا الأمر على

وقد تحتاج إلى هذا الخيار  . على هذه النقطة الصغيرة التى بأسفل العين لإخفاء الطبقة أى إخفاء الكائنات التى بها انقر. 3



2024قسم تكنولوجيا المعلومات / خضوري اعداد: أ.أوس رحال

77

فوقها كى ترى الكائنات التى كانت مغطاة بكائنات الطبقة  بشكل مؤقت عندما تعمل على طبقة وتريد إخفاء الطبقة التى

 . العلوية

 .أثناء النقر على النقطة Alt الأمر على كل الطبقات ماعدا الطبقة الحالية , اضغط ولتطبيق هذا

الإسم دالا على مهمة الطبقة أو على الكائنات  اسم الطبقة , انقر نقرة مزدوجة لتغيير الإسم كما تريد , ويفضل أن يكون. 4

ى المستقبل عند إجراء أى تعديلات إضافية . مثلا يستحسن وضع التصميم أو ف الموجودة بها وهذا سيساعدك كثيرا أثناء

. كما يفعل المحترفون a أو الإكتفاء بحرف Action فى طبقة مستقلة وفى هذه الحالة سيتم تسمية الطبقة Action الأكشن

نافذة خصائص الطبقة أيقونة تدل على نوع الطبقة , كما أن النقر عليها يظهر. 5

 :قليلا عند أنواع الطبقات ولكن سنتوقف

Normal الإفتراضية ةالطبق الطبقة العادية , وهى .

 Guide الطبقة التى  استعملناها فى درس الحركة باستخدام مسار . وفى نفس مفهوم الطبقة الدليلية تأتى طبقة دليلية , وقد

. روأيضا تعرفنا عليها فى نفس الدرس المذكو . Guided تتبعها وسيكون نوعها

Mask وبالطبع سيكون النوع ،طبقة قناع وسيأتى ذكرها فى درس قادم Masked مرتبطا بها . 

Folder ونريد تخفيف هذا الزحام  وتفيد هذه الطبقة عنما يكون لدينا عمل ضخم بع الكثير من الطبقات ، طبقة المجلد وهى

 . سنضعها داخل مجلد وكأننا بوضع كل عدة طبقات مرتبطة مع بعضها البعض داخل طبقة مجلد

حتى يمكنك التمييز بينها بسهولة أثناء انشغالك فى التصميم  لكل نوع من هذه الطبقات أيقونة تدل عليها Animateويجعل 

 التالية وقد قمت بتسمية كل طبقة بحسب نوعها , لننظر إلى الصورة
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والطبقة الأخيرة هى  , Guided طبقة تتبعها دليليالها أيقونتان , العلوية عنما يكون هناك  Guide الطبقة لاحظوا أن

 . الطبقة الدليلية قبل تحديد طبقة تتبعها

 . الأيقونة قم بالنقر عليها لتحديدها ثم انقر على هذه الأيقونة , أو اسحب الطبقة إلى هذه , لإلغاء طبقة. 6

 Layer Folder Insert لإضافة طبقة مجلد. 7

 Motion Guide Insert لإضافة طبقة دليلية. 8

 Insert Layer لإضافة طبقة عادية . 9

 دفعة واحدة التحكم فى كل الطبقات

. انظر للشرح داخل الصورة
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 المزيد من التحكم فى الطبقات

: أى طبقة وانقر بالزر اليمن للماوس حيث تظهر قائمة بالخيارات العديدة حدد

 إظهار كل الطبقات. 1

 لأخرىقفل الطبقات ا. 2

 إخفاء الطبقات الأخرى. 3

 إدراج طبقة جديدة. 4

 إلغاء الطبقة. 5

 دليلية تحويل هذه الطبقة إلى طبقة. 6

 إضافة طبقة دليلية. 7

 تحويل هذه الطبقة إلى طبقة قناع. 8

 إظهار القناع. 9

 إضافة طبقة مجلد. 10

 إلغاء طبقة المجلد المحددة. 11

 قات التى بداخلهتوسيع طبقة المجلد بإظهار الطب. 12

 الطبقات التى بداخله تقليص طبقة المجلد بإخفاء. 13

بداخلها توسيع كل طبقات المجلدات وإظهار الطبقات التى. 14

 تقليص كل طبقات المجلدات وإخفاء الطبقات التى بداخلها. 15

 . إظهار لوحة خصائص الطبقة. 16

 : ملحوظة

. دليلية إلى طبقة المجلد , وبنفس الطريقة يمكنك جعل طبقة تتبع طبقة طبقة مجلد , اسحب الطبقة لوضع طبقة داخل

:مثال: صمم مشهدا تستخدم فيه طبقات قدر حاجتك تظهر فيه 

 خلفية لحديقة وقفلها .1

دخول نحلة تطير طيرانا حرا حسب مسار يحثي تدخل من خارج المسرح وتدور فيه حسب المسار  .2

ية )حسب مسار(المرسوم ثم تخرج من الجهة الثان

 )حسب مسار( الأرضسقوط ورقة شجر من شجرة على  .3

( frame by frameدخول حشرة تزحف على المسرح و تأكل ورقة الشجر ) .4

ثواني 5طول المشهد ملاحظة :
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Buttonsالازرار 

:هو أحد الأنواع الثلاثة للرمز Button إن الزر

Graphic , Movie Clip , Buttons  

. كيفية إنشاء زر استعمالا فى صفحات الإنترنت . والآن لنتعرف على Animateيقات وهو أكثر تطب

Button . ارسم دائرة ثم حددها وحولها إلى رمز من نوع1

 . ولاحظ تغير شريط الزمن , لتدخل فى طور تحرير الرمز انقر على الدائرة نقرة مزدوجة - 2

إطارات للزر , وهذه الإطارات لن تعمل من  4يصنع تلقائيا  فإن البرنامج Button عندما تقوم بإنشاء رمز من نوع زر

 . لتفاعل مؤشر الماوس تلقاء نفسها وإنما تستجيب

. بدون وجود مؤشر الماوس فوقه ةوهو يمثل شكل الزر فى الحالة العادي Up الإطار الأول -

 . مؤشر الماوس فوقه وهو يمثل شكل الزر عند مرور Over الإطار الثانى -

 . وهو يمثل شكل الزر فى لحظة النقر عليه Down الإطار الثالث -

ل إلى شكل اليد عندما يمر الماوس فوقها يتحو وهو يمثل المنطقة الفعالة فى الزر , أى المنطقة التى Hit الإطار الرابع -

المستخدم أنه عند النقر هنا سيحدث شيئ ما مثل الذهاب إلى عنوان صفحة ويب أو  لكى يعلم , التى نعرفه جميعا

  ملف موسيقى أو تحميل ملف موجود .. إلخ تشغيل

 . تصميم الزر حتى نفهم هذه الإطارات بشكل أوضح والآن لنكمل

 فى هذا الإطار بمعنى أنه فى الحالة Key frame وافتراضيا يكون لدينا إطار مفتاحى , نحن الآن فى الإطار الأول

 . العادية وعند عدم استخدام الزر فسيكون ظاهرا دائما بلونه الأحمر

الدائرة إلى الأزرق  وقم بتغيير لون , Key frame لإدراج أطار مفتاحى F6 ثم اضغط Over الإطار الثانى انقر على -

 . لونه من الأحمر إلى الأزرق مثلا . ومعنى ذلك أنه عند مرور مؤشر الماوس فوق الزر سيتغير

ة إلى الأسود وقم بتغيير لون الدائر , Key frame إطار مفتاحى لإدراج F6 ثم اضغط Down انقر على الإطار الثالث -

إلى الأزرق  لون الدائرة سيتغير إلى الأسود فى لحظة النقر بالماوس , وعند إفلات الماوس سيعود مثلا , ومعنى ذلك أن

 . وعند سحب الماوس يعود للأحمر

 س فوقهاخلال هذا الإطار يمكننا تحديد المنطقة الفعالة التى عند مرور مؤشر الماو ومن , Hit انقر على الإطار الرابع -

عند مرور مؤشر الماوس فوق أى  يتحول إلى شكل يد , وفى الحالة الإفتراضية تكون هذه المنطقة هى الزر بالكامل , أى

المنطقة الفعالة هى منطقة يتم تحديدها بأى شكل دائرة .. مربع ..  جزء من الزر سيتحول إلى يد . ويجب أن نفهم أن هذه

 . اية منطقة وهمية بمعنى أنها غير مرئيةفهى فى النه. مثلث .. إلخ لا يهم

 الإطار المنطقة الفعالة دائرة صغيرة فى مركز الزر , ولعمل ذلك سنقوم بتصغير الدائرة فى هذا لنفرض أننا نريد أن تكون

. 
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 . Hit انقر على الإطار - 1

 . قم بتحديد الدائرة فى منطقة المسرح - 2

 اذهب للقائمة - 3

Window >Info وحة المفاتيح اضغطأو من ل Ctrl+I

المنطقة الفعالة دائرة صغيرة داخل الدائرة الكبيرة , ولكن  قم بتقليل حجم الدائرة بنفس القدر عرضا وارتفاعا , الآن جعلنا

إلى البرنامج  كز الدائرة الأكبر كما أردنا ؟ هذا السؤال لا أوجهه لك عزيزى القارئ وإنما أجههمر هل الدائرة الصغيرة فى

: مندهشا Animate, وعلى الفور يجيبنى 

 ! منى ذلك كيف لى أن أعرف , أنت لم تطلب -

 ! ماتطلبه وليس ما تتمناه هذا صحيح , ففى كل برامج الكمبيوتر المختلفة يعطيك البرنامج فقط

 Onion Skin أيقونة سنحاول الآن أن نرى مكان الدائرة الصغيرة , انقر على

ضى الذى سنقوم الإفترا الدائرة الصغيرة تتحاذى من الناحية العليا اليسرى للدائرة الأصلية , وهذا هو الوضع سنجد أن

  بتعديله

. عدة خطوات حتى تختفى الدائرة الصغيرة Ctrl+Z بالتراجع عن طريق قم -

 انقر على نقطة المركز فى لوح وضعية الرمز Info فى لوح-
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 حجم الدائرة عرضا وارتفاعا كما فعلنا من قبل , وشاهد النتيجة الآن قلل -

. مرة أخرى للعودة إلى الوضع العادى Onion Skin أيقونة انقر على -

 . قم باختبار العمل -

وظيفة للزر تعيين

أى شيئ وإلا فما فائدته ؟ , لنجرب الآن مثالا بسيطا : عند النقر على الزر  .. عند النقر على أى زر لابد من حدوث شيئ

 . تشغيل ملف موسيقى سيتم

  من القائمة - 1

File > Import > Import to Library

. وضع ملف الصوت فى المكتبة لقد تم . mp3 وقم باختيار أى ملف صوت لديك ويستحسن أن يكون بصيغة

 Down إطار الزر , وانقر على انقر نقرا مزدوجا على الزر لتدخل فى طور تحرير - 2

. استوردناه للتو . واترك الخيارات الباقية كما هى فى لوح الخواص , اختر الملف الذى sound فى قسم - 3

. العمل اختبر - 4

 Invisible Button الزر الخفى

مؤشر الماوس إلى يد  يكون لدينا نص عبارة عن كلمة مثلا ونريد أن يكون لتلك الكلمة خصائص الزر بمعنى تحول أحيانا

هو الحال مع الأزرار العادية , وفى هذه الحالة سنكتب  عند المرور فوقها, وحدوث إجراء ما عند النقر عليها, تماما كما

 ائى لن يظهر الزر الخفى بالطبع وإنما سنرى النص فقط والذى سيكون لهوفى الفيلم النه ,النص ثم نضع الزر الخفى فوقه
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 . كل وظائف الزر

 . اكتب نص من كلمة أو كلمتين. 1

 ولا يهم اللون لأننا فى النهاية سنحوله إلى , Rectangle Tool مستطيل باستخدام أداة سنصنع الآن زرا عبارة عن. 2

 . زر خفى

 Button ه إلى رمز من نوعقم بتحديد المستطيل ثم حول. 3

 . المستطيل نقرة مزدوجة للدخول فى طور تحرير الزر انقر على. 4

 . Hit وضعه فى إطار Up إطار اسحب الإطار المفتاحى من . 5

المستطيل قد تغير لونه  للعودة إلى المشهد , وسنلاحظ أن لون Timeline لسهم فى منطقةأو على ا Scene1 على انقر. 6

. . اسحب المستطيل وضعه فوق النص

. كل زرالعمل , لن نرى الزر الخفى وإنما سنرى نص على ش اختبر. 7

:Code Snippetsمن خلال  إضافة كود برمجي للازرار

بسرعة.  ActionScript 3.0و  JavaScriptلتسهيل بدء غير المبرمجين باستخدام  Code Snippetsتم تصميم لوحة 

 Code Snippetsالخاص بك لتمكين الوظائف الشائعة. لا يتطلب استخدام لوحة  FLAافة رمز إلى ملف يتيح لك إض

 .ActionScript 3.0أو  JavaScriptمعرفة 

، يمكنك: Code Snippetsباستخدام لوحة 

 أضف كوداً يؤثر على سلوك كائن على المسرح

 نيأضف رمزًا يتحكم في حركة رأس التشغيل في المخطط الزم

 (CS5.5  )إضافة رمز يسمح بتفاعل المستخدم مع شاشة اللمس -فقط

 أضف مقتطفات رمز جديدة تقوم بإنشائها إلى اللوحة
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أو  JavaScriptأيضًا طريقة جيدة لبدء تعلم  Animateيعد استخدام قصاصات التعليمات البرمجية المضمنة في 

ActionScript 3.0 واتباع تعليمات المقتطف ، يمكنك البدء في فهم بنية الشفرة . بالنظر إلى الشفرة في المقتطفات

 .والمفردات

 ثن نختارها من القائمة فيظهر المربع التالي:  Windowنضغط على   Code Snippetsلفتح لائحة 

فتظهرالنافذة ActionScriptنضغط على 

وذلك  الكود. يستخدم في )مثيل( لاضافة أي مقتطف برمجي لعنصر على المسرح يجب ان يكون لهذا العنصر اسم محدد

كما يلي:

 نحدد الزر  .1

ن يكون قصيرا ودالا على و يفضل ا Instance Nameنكتب اسما للرز في مربع   propertiesفي جزء  .2

العنصر
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أضف مقتطف رمز إلى كائن أو إطار مخطط زمني

 لإضافة إجراء يؤثر على كائن أو رأس التشغيل:

 .حدد كائناً على المسرح أو إطارًا في المخطط الزمني

  إذا حددت كائناً ليس مثيلًا للرمز ، فإنAnimate لمقتطف.يحول الكائن إلى رمز مقطع فيلم عند تطبيق ا

  إذا حددت كائناً ليس له اسم مثيل بالفعل ، فإنAnimate .يضيف كائناً عند تطبيق المقتطف

  في لوحةCode Snippets (Window> Code Snippets)  ،الذي تريد  انقر نقرًا مزدوجًا فوق المقتطف

 تطبيقه.

  إذا قمت بتحديد كائن على الجزء الرئيسي ، فإنAnimate ى لوحة يضيف المقتطف إلActions  في الإطارات

 التي تحتوي على الكائن المحدد.

  إذا قمت بتحديد إطار زمني ، فإنAnimate .يضيف المقتطف إلى هذا الإطار فقط

  في لوحةActions  اعرض الشفرة المضافة حديثاً واستبدل أي عناصر ضرورية وفقاً للتعليمات الموجودة ،

 أعلى المقتطف.

(Stop / Playرار )إضافة از : 1 مثال

مشهدا لدائرة تتحول الى نجمةصمم  .1

عل كل من حالات الزر F6و ادخل الى نمط تحريرالزر و اضغط  ( stop)لزر  اضف زر بشكل بيضاوي .2

stop_butمثلا  سم الزر من الخصائص .3

Code Snippetsثم  Windowنحدد الزر ثم نختار قائمة  .4

لاضافته للزر Mouse Click Events  نقرا مزدوجا على انقر ثم Event Handlersثم  Actionsنختار  .5

تظهر نافذة فيها كود بالشكل .6
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مع فاصلة منقوطة بالاخر       ;()stopو نكتب بدلا منه   start your custom code hereنحذف سطر 

;()stopبدلا من   ;()Playمع كتابة الامر  Playنكرر الخطوات لاضافة زر  .7

لانتقال الى موقع على النت()ا : 2 مثال

: إضافة إلى الإطار1الطريقة  -تطبيق مقتطف 

اتبع هذه الخطوات لتطبيق مقتطفك الأول:

 مثلا مستطيل ارسم شكلاً على الجزء الرئيسي وحدده .1

 Click To Go Toوانقر نقرًا مزدوجًا فوق مقتطف  Actions، قم بتوسيع فئة  Code Snippetsفي لوحة  .2

Web Pageوضح الإشعار أنه سيتم تحويل الشكل إلى مقطع فيلم. ي

عند النقر فوق الشكل ، . Control> Test Movieويتم إدراج التعليمات والرمز. اختر  Actionsتفتح لوحة  .3

وهي الصفحة الافتراضية و لكن يمكن  www.adobe.comيجب أن يفتح متصفح الويب الخاص بك وينقلك إلى 

كتابة أي موقع اخر نريد الانتقال اليه

(بين المشاهد)الانتقال  : 3 مثال

shapetweenنجمة  صمم مشهدين : الأول دائرة تتحول الى

الثاني مربع يتحرك على المسرح 

. الان نريد ان يشتغل المشهد الأول مرة الثاني مباشرة عند تشغيل الفيلم نلاحظ ان المشهد الأول سيظهر وعند انتهائه سيبدأ

واحدة ويتوقف بعدها، لذلك نقوم بما يلي:

 code snippetsثم   windowنحدد الاطار الأخير في الطبقة ثم نختار  .1

stop at this frameثم ننقر نقرا مزدوجا على    timeline navigationsثم   Actionsنضغط على  .2

http://www.adobe.com/
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فيظهر الكود التالي .3

الكودصغي عند الاطار الخير في الطبقة مما يدل على إضافة  aفنلاحظ ظهور حرف  نغلق المربع .4

اني تلقائيا وانما يجب اضافة كائن لنقلهالان لو شغلنا الفيلم لن ينتقل للمشهد الث     

movieclipلاضافة الكائن، نضيف طبقة جديدة و نرسم بها مستطيل مثلا و نحدده و نحوله لرمز من نوع  .5

و نختار  time line navigationنحدد المستطيل ثم نفتح نافذة المقتطفات و نضغط على  .6

 go to and play scene ريد الانتقال اليه و هو هنا و نكتل اسم المشهد الذي نScene2 
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Scene 1للانتقال الى   Scene 2نكرر الخطوات على  .7

sMovieClip  مقاطع الأفلام

الشديدة الأهمية . وفهمك له جيدا سيمنحك القدرة على التعامل  هذا الدرس بالرغم من قلة حجمه , إلا أنه من الدروسان  

ببساطة هو عبارة عن مجموعة أفكار بسيطة تترابط لينتج عنها أعمال  Animateفبرنامج  , بشكل مبتكر Animateمع 

 . مبهرة

أن الأنواع الأخرى من الرموز ترتبط فى  وهذا هو النوع الثالث من أنواع الرموز , وإذا كان لكل رمز زمنه الخاص به إلا

لا يرتبط زمنه بزمن المشهد  Movie Clip الذى نتحدث عنه اليوم وهو النهاية بالزمن الأصلى للمشهد , ولكن النوع

الثلاثة للرموز  الاستمرار حتى بعد انتهاء زمن المشهد . ولن نفهم ذلك بشكل أوضح إلا بمقارنة الأنواع بمعنى أنه يمكنه

. بعضها ببعض

إلى مقارنته من نطاق المقارنة , لأن اختلافه واضح ولا يحتاج  Button عند المقارنة سنخرج النوع الثانى وهو الزر

. السابق إطارات تعمل كلها أو أحدها بالتفاعل مع الماوس كما أوضحنا فى الدرس 4يتكون من  لرؤية وجه الخلاف , فهو

. دائما يحدث لبس بين هذين النوعين لأنه , Graphic يتبقى الآن أن نشرح الفرق بينه وبين النوع الأول وهو ال

 . الغالب إلى دوامة من المتاهات , دعونا نفهم الأمر بشكل عملى صلنا فىوبدلا من الشروحات النظرية التى تو

: مايحلو لك وكما تعلمنا من قبل يمكننا فعل ذلك بعدة طرق اختر منها ,New Symbol بإنشاء رمز جديد سنقوم الآن - 1

  Ctrl+F8 من لوحة المفاتيح اضغط

 Insert > New Symbol أو من القائمة

. ( الأيقونات فى اليسار وهى آخر ) New Symbol انقر على أيقونة Library المكتبةأو فى أسفل لوح 

 Create New Symbol وفى أى من هذه الحالات ستظهر لوحة

 .Ok ثم اضغط , Graphic واختر نوعه Container قم بتسمية الرمز

وهذا  -الرمز , وثانيا  المقصود من تسمية الرمز بمعنى حاوية أو وعاء أو صندوق وذلك لأنه أولا يعبر عن مفهوم لاحظ

. ! لأننا سنضع شيئا آخر بداخله , وسيكون ذلك مفاجأة -هو الأهم 

المسرح ) لأننا ببساطة لم نعد فى  ى حدودنحن الآن فى منطقة تحرير الرمز حيث تجد مساحة بيضاء فارغة ولا نر -2

 Graphic قم برسم دائرة وحددها ثم حولها إلى رمز من نوع , ( مسرح المشهد وإنما نحن فى المسرح الخاص بالرمز

 ثم قم بتغيير موضع , Key frame لإدراج إطار مفتاحى F6 واضغط 30على الإطار رقم  كما تعلمنا من قبل , ثم انقر

 ) Motion فى الخصائص نوع Tween الجهة المقابلة , ثم انقر على الإطار الأول من جديد واختر من قائمة الدائرة إلى

بالتفصيل فى درس سابق ويمكنك العودة إليه مرة أخرى لتتذكر  أعتقد أنه لا حاجة لشرح ذلك بالصور لأننا شرحنا ذلك

. ( التفاصيل

شيئا سيكون مفاجأة بالنسبة لك  رتها منذ قليل , وهى أننا سنضع داخل الرمزينبغى أن نتوقف الآن عند نقطة هامة ذك ولكن

اتفقنا أن الرمز ماهو إلا صندوق فمالذى يمنعنا من وضع  , لقد وضعنا داخل الرمز الأصلى رمزا آخر , ومادمنا قد

اخل العش . وهو مصطلح يعنى وضع شيئ د , Animate Nestingيسمى فى لغة  صندوق داخل صندوق آخر ! وهذا
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 . ات بتأثيرات مذهلة ماكانت لتتم إلا بهذه الطريقةAnimateالرموز داخل بعضها عمل  ويمكنك عن طريق وضع

وبالطبع ستجد أن  , Timeline أو النقر على السهم فى منطقة خط الزمن Scene 1عد الآن إلى المشهد بالنقر على - 3

من المكتبة إلى  Container المسرح , لذا قم بسحب الرمز بة وليس فىالمسرح خال لأننا قمنا بتصميم الرمز فى المكت

. المسرح

 .. واستعد للمفاجأة , Flash Player لاختبار العمل فى بيئة Ctrl+Enter الآن اضغط - 4

أخطأنا والممثلين , هل  ؟ وأين الحركة التى أنشأناها منذ قليل ؟ .. لا يوجد شيئ سوى مسرح خال من المشاهد ماذا حدث

 .. فى شيئ ؟ .. دعونا نتأكد من ذلك

. بأداة التحديد على رمز الدائرة فى المسرح لتدخل فى الزمن الخاص بالرمز انقر نقرة مزدوجة

 , Motion Tween وبها سهم دلالة على أن لدينا لونها أزرق فاتح 30حتى  1كل شيئ يبدو على مايرام , الإطارات من 

من الإطار الأول إلى الأخير لتجد أن الحركة موجودة , ولكى نتأكد  Playhead ولكى نتأكد أكثر قم بتحريك رأس التشغيل

  وأكثر اذهب للقائمة أكثر

Window > Toolbars > Controllers 

صيغة الفيلم  , وستجد أن الحركة أيضا موجودة , إذن لماذا تختفى تلك الحركة فى Animateنامج بيئة بر وقم بالتشغيل فى

إلى زمن المشهد وتتأمل الإطارات , ماذا ترى  النهائى ؟ يمكنك معرفة الجواب ببساطة عندما تخرج من زمن الرمز وتعود

 ؟

  إطارا فى إطار واحد ؟ 30تحتاج إلى بالمنطق أن نتوقع حدوث حركة  لدينا إطارا واحدا فقط , إذن كيف

زمن الإطار  من لوحة المفاتيح ) لتمديد F5 ثم اضغط 30انقر على الإطار رقم  -المقصود !  -الخطأ  ولتصحيح ذلك

  ( 30الأول حتى الإطار رقم 

. ولا تخف .. لا توجد مفاجآت هذه المرة , Ctrl+ Enter العمل بالضغط على لآن اختبرا

  Graphic بدلا من Movie Clip هو من نوع Container لنرى ماذا كان سيكون الحال لو أن رمز والآن

 Delete فاتيح اضغطلتحديده ومن لوحة الم للتراجع حتى نعود للإطار الواحد . ثم انقر على الرمز Ctrl+Z اضغط - 5

. لإلغاؤه
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 واختر من القائمة Container للمكتبة وانقر بالزر الأيمن للماوس على رمز اذهب

Type > Movie Clip 

 لايزال يحتفظ بداخله برمز الدائرة والحركة من نوع ونلاحظ أنه , Movie Clip إلى Graphic لقد غيرنا نوع الرمز من

Motion Tween . 

 . Flash Player لاختبار العمل فى بيئة Ctrl+ Enter المسرح , ثم اضغط اسحب الرمز إلى

من المستقل عن ز له زمنه الخاص Movie Clip حركة بالرغم من وجود إطار واحد فقط , لماذا ؟ لأن الـ الآن توجد

 . Animateفيلم صغير نضعه داخل فيلم  هو عبارة عنMovie Clip المشهد الأساسى. أى أننا يمكن اعتبار أن الـ

الــقــنــــاع

 , وفى هذا المثال سنعتبر أن القناع عبارة عن طبقة نضعها فوق طبقة Animateللقناع فى  هنا سنورد مثالا مبسطا
 . بشكل كامل حة الستار أو القناع عن الصورة تدريجيا لتظهر لناأخرى بها صورة ونريد أن نقوم بإزا

1مثال 

: سنقوم بتصغير الملف قليلا , من القائمة – 1
Modify > Document

( Ctrl+J) أو من لوحة المفاتيح اضغط 
  Time Line فى Frame Rate أو انقر مرتين على مربع

 مقاس الملف كما فى الصورة ومنها قم بتغييروفى كل الأحوال ستظهر لك النافذة التالية 

. لون الخلفية أسود أيضا اجعل

  من القائمة -2
File > Import > Import to Stage

 Ctrl+R أو من لوحة المفاتيح اضغط 
. مسرح العمل ثم اختر صورة لوضعها فى

 لقائمةل نريد الآن توسيط الصورة فى نقطة المركز فى المسرح , إذن سنذهب – 3
Window > Align 

  Ctrl+K أو من لوحة المفاتيح اضغط
: ألواح فى داخل لوح واحد 3فى منطقة الألواح على يمين المسرح , ولاحظ أنه  Align سظهر لوح
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Align , Transform , Info 
. ت السابقةكانت تلك الألواح الثلاث منفصلة فى الإصدارا وهو من التعديلات الجميلة فى هذا الإصدار , حيث

 لأننا نريد أن تكون المحاذاة بالنسبة للمسرح , ثم اختر To Stage انقر على ثم Align قم باختيار لوح
Align Horizontal Center , Align Vertical Center كما فى الصورة 

. لدينا الصورة تتوسط المسرح تماما الأن - 4

بالنقر مرتين على  ) Mask لإضافة طبقة جديدة فوق الطبقة الحالية وقم بتسميتها Insert Layer على زر انقر – 5
أثناء الرسم  Shift تماما ويستحسن أن تضغط مفتاح , ثم قم برسم دائرة فوق الصورة بحيث تغطى الوجهاسم الطبقة ( 

الدائرة بأى لون ملء ولكن بدون لون تحديد , لماذا بدون لون تحديد , السبب أن  للحصول على دائرة منتظمة وليكن لون
Animate فى منتصف المسرح  الملء فقط . ثم قم بجعل الدائرة لا يتعرف على لون التحديد فى القناع وإنما يرى لون

. كما تعلمنا من قبل

فة لإضا F6 فى شريط الزمن وانقر على مفتاح 25هى الفعالة , الآن انقر على الإطار  Mask الطبقة لازالت – 6
 . إطار مفتاحى

 Align الذى هو ضمن لوح) Transform ثم فى لوح , فى شريط الزمن الخاص بالطبقة 1انقر على الإطار رقم  - 7
مختارا وذلك لجعل  Constrain من الحجم الأصلى وتأكد بأن المربع % 10بنسبة  المفتوح سلفا ( اجعل حجم الدائرة

  عرضفى الحجم متساويا فى الطول وال التغيير
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 . الدائرة التى كانت تحجب الوجه وقد تحولت إلى دائرة صغيرة جدا جدا فى مركز الصورة الآن لدينا
. Shape النوع تراخ Tween ومن نافذة Properties لازال فعالا , اذهب إلى 1الإطار رقم  – 7

شريط إطارات الطبقة أصبح بهذا الشكل ستجد أن

ولإظهارها  , , بالطبع الصورة اختفت 25بقة الأولى التى هى طبقة الصورة , ثم انقر على الإطار الط انقر على – 8
المفاتيح وبذا نكون قد أضفنا إطارات  فى لوحة F5 نحتاج أن نقوم بتمديد الزمن الخاص بها , ولعمل ذلك اضغط على

 . 25والإطار  1بين الإطار 
Insert > Timeline > Frame : لقائمةإطارات أيضا بالذهاب إلى ا يمكن إضافة

Insert Frame بالزر الأيمن للماوس واختر أو انقر
 . الآن ستظهر الصورة عند آخر إطار

التغير التالى فى شكل كلا  حيث ستلاحظ , Mask انقر مرة أخرى على طبقة القناع بالزر الأيمن للماوس واختر – 9
الطبقتين مع وجود قفل عليهما

. لإختبار الفيلم Ctrl+Enter اضغط – 10

Maskالقناع

2مثال 

 . Dr Bahaa قم بكتابة نص قصير بالإنجليزية, مثلا هنا كتبت - 1
. ا تعلمنا من قبلاجعل النص فى منتصف المسرح كم Align من لوحة المحاذاة - 2
 Mask أضف طبقة جديدة وأسمها - 3
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المستطيل سيكون له  , قم برسم مستطيل ضلعه الأيمن على يسار النص مباشرة Mask للطبقة 1فى الإطار رقم  - 4
. Stroke ون حد خارجىلون تعبئة ولكن بد

لإدراج إطار مفتاحى , وقم بنقل المستطيل إلى الجهة اليمنى من النص ,  F6 اضغط Mask لطبقة 40فى الإطار  - 5
. نهاية النص مباشرة الضلع الأيسر للمستطيل على يمين أى بحيث يكون

 . Shape Tween لنفس الطبقة واختر نوع الحركة 1اذهب مرة أخرى للإطار  - 6
لإدراج إطارات ) حتى يستمر ظهور النص حتى ذلك  F5 واضغط Layer 1 الأولى من الطبقة 40اذهب للإطار  - 7

( الإطار
 . ستظهر لكمن الخيارات التى  Mask : واختر Mask انقر على إسم الطبقة - 8
 تدريجيا . فى الحقيقة إن المستطيل الذى وضعناه فى طبقة اختبر العمل وسترى أن النص يظهر تدريجيا ويختفى - 9

Mask ومكانه فى الإطار  1بتحديد مكان المستطيل فى الإطار  يتحرك من اليسار إلى اليمين وقد حددنا إتجاه الحركة
. الأخير

 . ف منها أن تتعلم كيفية عكس الإطاراتبإضافة صغيرة الهد والآن لنقم
منطقة الإطارات  فى منطقة الإسم , أو انقر نقرة مزدوجة على نفس الطبقة فى Mask الطبقة انقر نقرة واحدة على - 1

. , وفى كلا الحالتين سيتم تحديد كل الإطارات
ثم اترك  , مين الإطارت الحالية مباشرةفى لوحة المفاتيح بينما تسحب الإطارات المحددة إلى ي Alt اضغط مفتاح - 2
. فى أغلب برامج التصميم Alt لقد قمنا بنسخ الإطارات . وهذه ميزة شهيرة لمفتاح , Alt مفتاح
 الأيمن للماوس واختر بتحديد الإطارات الجديدة التى نسخناها ) انقر عليها نقرة مزدوجة ( , ثم انقر بالزر قم - 3

Reverse Frames , من اليمين لليسار ( فى الإطارت  لك أن المستطيل سيتحرك فى الإتجاه العكسى ) أىومعنى ذ
. الجديدة
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باستخدام برنامج الوسيط  يةقم بتغيير النص بنص باللغة العرب41 انقر على الإطار , Layer 1 فى الطبقة الأولى - 4
. لتمديد ظهور النص حتى ذلك الإطار F5 واضغط 80مثلا , ثم قم بالنقر على الإطار 

 . الآن اختبر العمل
 تطبيق على الدرس

السابق تطبيق آخرعلى الدرس

فى الدرس الحالى , ومهمتك الآن يابطل أن تقوم بتلك  حيث قمت بنسخ الطبقات وعكس الإطارات تماما كما فعلنا
 ولة وبساطةأشرح ذلك فأنت الآن تستطيع تنفيذ الخطوات بسه الخطوات بنفسك ولن تحتاج إلى أن

التعامل مع الصوت

 صوت أولا استيراد ملف

: أن يستورد ملفات الصوت بالصيغ التالية Animateيستطيع 

WAV 

MP3  

: طريق القائمة وتستطيع استيراد ملف الصوت إلى المكتبة عن

File > Import > Import to Library

http://www.alamuae.com/up/Folder-002/1148122502_Mask2.zip
http://www.alamuae.com/up/Folder-002/1148143957_mask2.zip
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Synchronizing Audio to Animations الصوت خيارات توافق

 : خيارات لتوافق الصوت 4هناك 

1 . Event

بالتزامن مع حدث ما مثل  فتراضى , ويعمل الصوتهذا هو الخيار الإ

على الزر مرة أخرى فسيتم تشغيل الصوت من جديد قبل  تقدم الفيلم حتى إطار معين أو النقر على زر , وإذا تم النقر

تداخل غير مرغوب فيه بالنسبة للأصوات . كما أن الصوت يستمر حتى بعد انتهاء  انتهاء الصوت الأول وهذا يؤدى إلى

 . إذ أنه يعمل بمعزل عن خط الزمن -أقول انتهاؤه وليس غلقه بواسطة المستخدم  - الفيلم

2 .Start 

. لا يمكن تشغيل نفس الصوت من جديد قبل انتهاء الصوت الحالى والفرق الوحيد أنه Event له كل مواصفات الخيار

3 . Stop 

 . لمفتاحى الذى به ملف الصوتالإطار ا سيتم ايقاف الصوت عندما يتقدم الفيلم إلى

4 .Stream 

 . الفيلم بغض النظر عن انتهاء مدة ملف الصوت أم لا يتزامن مع خط الزمن للفيلم وتوقف عند نهاية

معالج الكمبيوتر بطيئا فلن يكون  بالذكر أن هذا الخيار يجعل للصوت الأسبقية على الجرافيكس فى الفيلم , فإذا كان وجدير

مثلا تصميم حركة شفاه لشخص يتحدث , حيث يلهث مشغل  ن المطلوب بين الحركة والصوت إذا تمهناك التزام

Animate الإطارات ومن أجل ذلك سيضحى ببعض الإطارات بين الحين والآخر  من أجل موافقة الصوت لحركة

  . ويسقطها من حسابه

. الفيلم بكشل ملحوظ يؤدى ذلك إلى زيادة حجم مراعاة أن تكون حذرا فى استعمال التكرار مع هذا الخيار إذ ويجب

  تكرار الصوت

 الحقل الذى يلى الحقل عددا هائلا من المرات , ويمكنك كتابة عدد مرات التكرار التى تريدها فىتكرار الصوت  يمكن

Repeat 

Loop أو إذا كنت تريد أن يتكرر الصوت بشكل مستمر , فيمكنك اختيار
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 منالز ربط الصوت بخط
تريد أن يبدأ الصوت عنده , ثم تقوم  يجب إنشاء إطار مفتاحى عند الإطار الذى Timeline لكى تربط صوتا بخط الزمن

ولكنك لن تجد أى شيئ يوحى بوجود الصوت , وكل ماستراه هو تغير  , بسحب نظير من الصوت من المكتبة إلى المسرح

 ن لديك إطارا وحيداخط أفقى وحلقة صغيرة إذا كا شكل الإطار فيظهر به

. أو ترى بالإضافة لما سبق خطا به تموجات صغيرة إذا كان لديك عددا من الإطارات

مثلا 20الإطار  ويمكنك سحب الإطار المفتاحى الذى يبدأ عنده الصوت لجعل بداية الصوت عند

 . التى يبدأ عندها الصوت عن طريق تقديم أو تأخير الإطاراتوينصح دائما بوضع كل صوت فى طبقة خاصة , 

بتشغيل فيلم به طبقات عديدة من الأصوات وتعمل كل هذه الأصوات فى  أن يقوم Flash Player ويستطيع مشغل فلاش

بقة الط أن تستغل ذلك الأمر فى إضافة طبقتين للأصوات , تضع فى طبقة ملف موسيقى, وتضع فى وقت واحد , و يمكنك

تحدثنا عنها منذ قليل لعمل تزامن بين  الثانية ملف صوت لشاعر يلقى قصيدة شعر مثلا , ويمكنك استخدام المؤثرات التى

كما يمكنك أن تضع مقطع  , Fade out و Fade in واستخدام تأثيرى المقطوعة الموسيقية وبداية كل مقطع شعرى

استديوهات  ستطيع الآن تنفيذ مايقوم به مهندسو الصوت المحترفون فىكل فقرة شعرية , وهكذا ت موسيقى مختلف مع بداية

 . الإذاعة

 للزر إنشاء صوت
Event الصوت هو الخيار الإفتراضى يمكننا تعيين صوت يتم سماعه كلما تم النقر على زر محدد , ودائما يكون خيار
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 : الخطوات

ويندوز والتى نعرفها  زر مثل تلك الأصوات الموجودة فىاستورد إلى المكتبة ملف صوت يصلح لأن يكون صوتا لل. 1

 . جميعا

 زر بانشاءقم . 2

 الآن سندخل إلى نافذة تحرير الزر  . 3

 أو Edit بالزر الأيمن للماوس واختر الطريقة الأولى : فى المسرح انقر على الزر

Edit in place 

 : ملحوظة

الرمز , ولكن مع وجود فارق صغير , أنه فى الحالة الأولى لن تجد  تحرير يفتحان نافذة Edit , Edit in place كل من

الحالة الثانية فيمكنك  التحرير أى شيئ سوى الرمز ولن يمكنك رؤية العناصر الموجودة بمسرح العمل , أما فى فى نافذة

 . رؤية العناصر الأخرى الموجودة على المسرح

 Edit حيث تظهر نافذة اختر منها

الإطار الذى تريد  أضف إطار مفتاحى عندثم  , sound داخل نافذة تحرير الزر , أضف طبقة جديدة إسمها الآن نحن. 4

 الزر أضف الإطار المفتاحى عند الإطار ظهور الصوت عنده , فمثلا لو أردت سماع الصوت عند مرور الماوس فوق

Over , أضف الإطار المفتاحى عند الإطار ولو أردت أن يظهر عند الضغط على الزر Down 

من لوحة المفاتيح , أو النقر على الإطار بالزر الأيمن  F6 على غطوبالطبع إضافة الإطار المفتاحى عن طريق الض

Insert Keyframe للماوس واختيار
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 ف الصوتانقر على السهم المنسدل لإختيار مل Sound فى لوح الخواص فى حقل - 4

. كما هو Event الخيار اجعل Sync وفى حقل
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 Publishing moviesالأفلام نشر 

تعداد لنشره. يمكن تحميل الملفات التي على اس مرارا وتكرارا، أنت هعند الانتهاء من إنشاء ملف خاص بك، وقد اختبرت

يقوم الخادم بحيث يمكن عرض المشروع في المتصفح. عند نشر الملف،  تقوم بإخراجها عند النشر إلى مضيف

Animate  الفيلم الأصلي لاحظ أن تمن المهم أن . لذا فأصغر بكثير، وغير قابل للتحريربحجم ضغط البيانات في ملف ب

ملف يمثل  FLAاد ومن امتد Animateفي 

مفيد في حال  او التصميم هام جدا لانه التأليف

اما   الفيلم. كنت بحاجة إلى إجراء تغييرات على

عند  Animateتم إنشاؤه بواسطة سيملف الذي ال

سيتم تضمينه في  نشر مشروع هو الملف الذي

ولا يمكن  SWFومن امتداد  صفحة ويب

 تحريره.

:اتبع هذه الخطوات لنشر ملف

1.  File > Publish Settings. 

وتأكد من  Formatاختر علامة التبويب  .2

 FLASHو  HTMLتفعيل الخيارين 

 SWFينشر فقط  Animateمما يجعل 

file and an HTML file  مع الكود

 الذي تم تضمينه.
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في القائمة   Flash only اختيار وتحقق   HTML نشر ، حدد علامة التبويبالفي مربع الحوار إعدادات  .3

سوف فقط  swfعلى ملف  ملف بسيط يحتوييقوم بانشاء (. هذا القالب التالي)انظر الشكل   templateالمنبثقة 

عند معاينته في متصفح.

اضغط موافق .4

File > Publishاختر  .5

 Animate)بشكل افتراضي، يقوم  خزنت الملف افتح متصفح الويب. اختر ملف< فتح. انتقل إلى المجلد حيث  .6

انقر فوق المطلوب جنبا إلى جنب مع الملف الرئيسي( حدد الملف  دائما بحفظ الملفات المنشورة في نفس المجلد

 نافذة المتصفح. الآن في HTML  المضمن في صفحة swfفتح. يظهر ملف 




